Electric Power Technology

Data Acquisition and Management System

LVDAM-EMS System

User Manual
30328-E0

Printed in Canada
Table of Contents

SECTION 1  Overview of the LVDAM-EMS System ............................... 1-1

SECTION 2  Data Acquisition Interface

  Introduction .............................................. 2-1
  What is a Data Acquisition System? .................. 2-1
  DAI Module and Data Acquisition Card .............. 2-3
  Model 9051 Data Acquisition Interface .............. 2-4
  Model 9062 Data Acquisition Interface .............. 2-6

SECTION 3  LVDAM-EMS Software Installation Procedure

  Introduction .............................................. 3-1
  LVDAM-EMS Installation ............................... 3-1
  Running LVDAM-EMS ..................................... 3-2

SECTION 4  LVDAM-EMS Software

  Introduction .............................................. 4-1
  LVDAM-EMS ............................................... 4-5

SECTION 5  Familiarization with the LVDAM-EMS System

  Introduction .............................................. 5-1
  Procedure ............................................... 5-1

SECTION 6  Measuring Three-Phase Power with the LVDAM-EMS System

  Introduction .............................................. 6-1
  Procedure ............................................... 6-1

We Value Your Opinion!
Overview of the LVDAM-EMS System

The Lab-Volt Data Acquisition and Management for ElectroMechanical Systems (LVDAM-EMS), is a computer-based system for measuring, observing, and analyzing electrical and mechanical parameters in electromechanical systems and power electronics circuits. The LVDAM-EMS system consists of a data acquisition interface and the Lab-Volt software Data Acquisition and Management for ElectroMechanical Systems (LVDAM-EMS).

The data acquisition interface consists of a Data Acquisition Interface (DAI) module, a data acquisition card, and an interconnection cable. The DAI module is used to interconnect modules of the Lab-Volt ElectroMechanical and Power Electronics Systems with the data acquisition card. This card is installed in a IBM®-compatible personal computer (486 or higher). In brief, the DAI module converts the high-level voltages and currents found in electromechanical systems and power electronics circuits into low-voltage signals, and routes these signals to the data acquisition card. The low-voltage signals are then converted into digital data by the data acquisition card. Refer to Section 2 of this manual to obtain a complete description of the DAI module and data acquisition card.

The LVDAM-EMS software is a complete set of instruments that runs on a IBM®-compatible personal computer under the Microsoft® Windows™ operating environment. Available instruments are voltmeters, ammeters, power meters, an eight-channel oscilloscope, a phasor analyzer, and a harmonic analyzer. Furthermore, built-in capabilities for data storage and graphical representation, as well as programmable meter functions, allow unimagined possibilities for studying and analyzing electromechanical systems and power electronics circuits. Once running, the LVDAM-EMS software reads the data coming from the acquisition card and then uses this data to calculate the values indicated by the various meters, update the waveforms on the oscilloscope display, etc. Refer to Section 4 of this manual to obtain a complete description of the LVDAM-EMS software. Refer to Section 3 of this manual to know how to install and run the LVDAM-EMS software.

To quickly learn how to use the LVDAM-EMS system, it is recommended to perform the hands-on exercises in Sections 5 and 6 of this manual. Section 5 allows you to familiarize with the various instruments of the LVDAM-EMS system while Section 6 shows how to measure power in three-phase circuits using the LVDAM-EMS system.
Data Acquisition Interface

INTRODUCTION

This section deals with the data acquisition interface of the LVDAM-EMS system. The data acquisition interface consists of a Data Acquisition Interface (DAI) module, a data acquisition card, and the necessary interconnection cable.

The section is divided into four subsections. Subsection titled What is a data acquisition system? explains the advantages of using a data acquisition system for the study and analysis of electromechanical systems and power electronics circuits. It also explains the principles of operation of data acquisition systems.

Subsection titled DAI module and data acquisition card describes the roles of the DAI module and data acquisition card in the LVDAM-EMS system. It also introduces the two data acquisition interfaces (Models 9061 and 9062) which can be used in the LVDAM-EMS system.

The two remaining sections describe in detail the models 9061 and 9062 data acquisition interfaces that can be used in the LVDAM-EMS system.

WHAT IS A DATA ACQUISITION SYSTEM?

Studying electrical power circuits, especially three-phase power circuits, involves measuring different parameters and observing voltage and current waveforms. Voltage, current, power (active, reactive, apparent), impedance, motor speed, and torque are some of the many parameters usually measured, and phasor analysis can be essential for detailed three-phase study.

Because most conventional instruments only present one type of information, measuring all the different parameters requires a variety of instruments. The instruments are often limited with fixed scales and input ranges, most oscilloscopes only have two channels, and torque/speed measuring devices are not commonplace items. The amount of information that must be collected becomes enormous, and most data analysis, calculation, and plotting of graphs must be done by hand. Therefore, in-depth study of many circuits is not always easy to do with conventional equipment.

A data acquisition system is a computer-based system that can gather and analyze information from many external sources, and perform different calculations on the acquired data. A single computer can thus replace a large number of meters and instruments, display many waveforms at the same time, analyze waveforms and data to extract important information, record data, and plot graphs.
Data Acquisition Interface

Generally, data acquisition systems gather information represented by electrical signals. Some information, such as the input or output voltage of an electrical device, is already in electrical form. Other information can be changed into electrical form by a transducer. For example, the speed of a motor can be converted into an electrical signal by a speed sensor.

The electrical signal from a speed sensor is called an analog signal because it is analogous to the speed; if the speed increases, the voltage increases, and vice versa. The voltage of an analog signal can vary continuously and take on any value within a certain range.

Computers are digital devices that use discrete numbers to store and process data. A data acquisition system therefore requires a circuit which converts continuous analog signals to discrete digital values. The type of circuit used for this purpose is called an analog-to-digital converter, or A/D converter. The sampling and conversion process is illustrated in Figure 2-1.

![Diagram of A/D conversion](image)

**Figure 2-1.** Sampling and analog-to-digital (A/D) conversion of an analog signal.

The analog signal is first sampled at regular intervals by a sample-and-hold circuit, which holds each sampled level until the analog-to-digital (A/D) converter has converted it to a digital number. The rate at which the signal is sampled is called the sampling rate. The higher the sampling rate, the more faithfully the digital numbers produced will follow the original signal. High sampling rates, however, generate lots of numbers and these may fill up the computer memory very quickly, so the sampling rate should not be too high. In theory, the lowest sampling rate that can be used is equal to twice the frequency of the highest frequency component in the analog signal. In practice, most systems use a somewhat higher sampling rate than that.

When a data acquisition system must acquire data from several different sources, a single A/D converter can be used along with a multiplexer, as shown in Figure 2-2. The multiplexer is a switch that selects each analog input, or channel, in turn. Each time the multiplexer selects a new analog input, the signal present at the input is sampled and converted to a digital number.

The number of channels sampled by the multiplexer affects the sampling rate per channel. If the A/D converter can convert 100,000 samples per second, a single channel could be sampled at that rate. However, if two channels were used, each
channel would be sampled at 50,000 samples per second, and four channels would be sampled at 25,000 samples per second each.

![Image of a typical multi-channel A/D converter](image)

**Figure 2-2. Input configuration of a typical multi-channel A/D converter.**

Depending on the application, a data acquisition system may sample signals continuously, or it may take a certain number of samples and then stop sampling until commanded to take another batch of samples. In either case, the digital numbers representing the samples can be processed and analyzed by the computer to extract useful information. In many cases, this information can be presented on the computer screen in different ways, which are selected by the user of the system.

**DAI MODULE AND DATA ACQUISITION CARD**

In the LVDAM-EMS system, the data acquisition system, or data acquisition interface, consists of a DAI module and a data acquisition card. A cable connects the DAI module to the data acquisition card, which is installed in an IBM®-compatible personal computer.

The DAI module converts the high-level voltages and currents applied to its voltage and current inputs into low-voltage signals. Each low-voltage signal is proportional to, and electrically isolated from, the high-level electrical signal present at the corresponding input. The low-voltage signals, and other signals coming from low-voltage inputs of the DAI module, are routed to the analog inputs of the data acquisition card through the interconnection cable.

The data acquisition card contains the circuitry needed for sampling and A/D conversion. It converts the low-voltage signals coming from the DAI module into corresponding digital data. The digital data is then read and analyzed by the LVDAM-EMS software running in the personal computer, to display the results on the computer screen according to the representation selected by the user. The
display can be a panel of meters indicating the values of the measured parameters, an oscilloscope showing the waveforms of the measured parameters, etc. Figure 2-3 gives an overview of the complete process.

Figure 2-3. Overview of the data acquisition and management process in the LVDAM-EMS system.

Either one of the following two data acquisition interfaces is included in the LVDAM-EMS system:

- Data Acquisition Interface, Model 9061, which consists of DAI module 9061 and data acquisition card PCL-711B;

- Data Acquisition Interface, Model 9062, which consists of DAI module 9062 and data acquisition card ACL-8112PG.

These two data acquisition interfaces are very well suited for studying and analyzing electromechanical systems. However, Model 9062 Data Acquisition Interface, which is more powerful and offers additional features, is necessary for studying and analyzing power electronics circuits.

**MODEL 9061 DATA ACQUISITION INTERFACE**

The front panel of DAI module model 9061 is illustrated in Figure 2-4. The DAI module is housed in a half-height EMS module so that it can be easily installed in the EMS Workstation. It consists of three high-voltage measurement inputs (E1 to E3), three high-current measurement inputs (I1 to I3), a torque measurement input (ANALOG INPUT T), a speed measurement input (ANALOG INPUT N), and an ANALOG OUTPUT. Access to inputs E1 to E3 and I1 to I3 is through 4-mm safety banana sockets mounted on the front panel. Access to the ANALOG OUTPUT and ANALOG INPUTS T and N is through miniature banana sockets, also mounted on the front panel.
Data Acquisition Interface

![Data Acquisition Interface Diagram](image)

Figure 2-4. Front panel of DAI module model 9061.

Inputs E1 to E3 and I1 to I3 are fully protected against over-voltage and short-circuit conditions. Furthermore, these inputs are electrically isolated from the circuitry in the DAI module through voltage and current isolators, respectively. This allows direct connection to electrical power circuits. Each of these isolators has two measuring ranges (high and low), the range selection being controlled by the LVDAM-EMS software. The following table indicates the rating of the low and high ranges of the voltage and current isolators, for the various versions of the DAI module.

<table>
<thead>
<tr>
<th>DAI MODULE VERSION</th>
<th>INPUTS E1 TO E3</th>
<th>INPUTS I1 TO I3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LOW RANGE</td>
<td>HIGH RANGE</td>
</tr>
<tr>
<td>9061-00, -01, -02</td>
<td>±100 V</td>
<td>±400 V</td>
</tr>
<tr>
<td>9061-05, -06, -07</td>
<td>±200 V</td>
<td>±750 V</td>
</tr>
</tbody>
</table>

Table 2-1. Rating of the low and high ranges of the voltage and current isolators in DAI module 9061.

ANALOG INPUTS T and N are used for measuring the torque and speed of a motor, respectively. ANALOG INPUT T is designed to receive the output signal of a torque sensor having a sensitivity of 0.3 N·m/V (2.66 lbf-in/V). Similarly, ANALOG INPUT N is designed for a speed sensor with a sensitivity of 500 r/min / V. For example, ANALOG INPUTS T and N of the DAI module can be connected to the corresponding outputs of the Lab-Volt Prime Mover / Dynamometer, Model 8960.
Data Acquisition Interface

The ANALOG OUTPUT provides a voltage which can be varied between +10 V and -10 V using the LVDAM-EMS software. This voltage can be used to control a device in an electrical power circuit through the LVDAM-EMS software.

All input and output signals between the DAI module and the data acquisition card and computer are routed through the COMPUTER I/O connector to which the cable to the data acquisition card is connected. Various control signals for range selection on the isolators and verification of their status are also present on this I/O bus.

To operate normally, low-voltage ac power (24 V) must be connected to one of the LOW POWER INPUT jacks on the front panel of the DAI module. The POWER ON LED confirms the presence of input power.

Data acquisition card PCL-711B has eight analog inputs and one analog output. It is equipped with a 12-bit A/D converter and the maximum sampling frequency is 25 kHz. Refer to the instruction manual of Model 9061 Data Acquisition Interface (30425-D0) to know how to install the data acquisition card in the computer.

MODEL 9062 DATA ACQUISITION INTERFACE

The front panel of DAI module 9062 is illustrated in Figure 2-5. The DAI module is housed in a half-height EMS module so that it can be easily installed in the EMS Workstation. It consists of three high-voltage measurement inputs (E1 to E3), three high-current measurement inputs (I1 to I3), a torque measurement input (ANALOG INPUT T), a speed measurement input (ANALOG INPUT N), two ANALOG OUTPUTS, eight AUXILIARY ANALOG INPUTS, and a SYNC. INPUT. Access to inputs E1 to E3 and I1 to I3 is through 4-mm safety banana sockets mounted on the front panel. Access to ANALOG INPUTS T and N, the ANALOG OUTPUTS, the AUXILIARY ANALOG INPUTS, and the SYNC. INPUT is through miniature banana sockets also mounted on the front panel.
Data Acquisition Interface

Figure 2-5. Front panel of DAI module 9062.

Inputs E1 to E3 and I1 to I3 are fully protected against over-voltage and short-circuit conditions. Furthermore, these inputs are electrically isolated from the circuitry in the DAI module through voltage and current isolators, respectively. This allows direct connection to electrical power circuits. Each of these isolators has two measuring ranges (high and low), the range selection being controlled by the LVDAM-EMS software. The following table indicates the rating of the low and high ranges of the voltage and current isolators, for the various versions of the DAI module.

<table>
<thead>
<tr>
<th>DAI MODULE VERSION</th>
<th>INPUTS E1 TO E3</th>
<th>INPUTS I1 TO I3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LOW RANGE</td>
<td>HIGH RANGE</td>
</tr>
<tr>
<td>9062-00, -01, -02</td>
<td>±100 V</td>
<td>±400 V</td>
</tr>
<tr>
<td>9062-05, -06, -07</td>
<td>±200 V</td>
<td>±750 V</td>
</tr>
</tbody>
</table>

Table 2-2. Rating of the low and high ranges of the voltage and current isolators in DAI module 9062.

ANALOG INPUTS T and N are used for measuring the torque and speed of a motor, respectively. ANALOG INPUT T is designed to receive the output signal of a torque sensor having a sensitivity of 0.3 N-m/V (2.66 lbf-in/V). Similarly, ANALOG INPUT N is designed for a speed sensor with a sensitivity of 500 r/min / V. For example, ANALOG INPUTS T and N of the DAI module can be connected to the corresponding outputs of the Lab-Volt Prime Mover / Dynamometer, Model 8960.
Data Acquisition Interface

Each of the two ANALOG OUTPUTS provides a voltage which can be varied between +10 V and -10 V using the LVDAM-EMS software. Each voltage can be used to control a device in an electrical power circuit through the LVDAM-EMS software.

AUXILIARY ANALOG INPUTS 1 to 8 are low voltage inputs (±10 V max.). These inputs can be connected to the outputs of voltage isolators, current isolators, torque sensors, speed sensors, etc. to measure various type of parameters. Each of these inputs is programmable through the LVDAM-EMS software.

The SYNC. INPUT is a digital input (TTL levels). It is used for external synchronization of the oscilloscope in the LVDAM-EMS system.

All input and output signals between the DAI module and the data acquisition card and computer are routed through the COMPUTER I/O connector to which the cable to the data acquisition card is connected. Various control signals for range selection on the isolators and verification of their status are also present on this I/O bus.

To operate normally, low-voltage ac power (24 V) must be connected to one of the LOW POWER INPUT jacks on the front panel of the DAI module. The POWER ON LED confirms the presence of input power.

Data acquisition card ACL-8112PG has sixteen analog inputs, and two analog outputs. It is equipped with a 12-bit A/D converter and the maximum sampling frequency is 90 kHz. Refer to the instruction manual of Model 9062 Data Acquisition Interface (31203-D0) to know how to install the data acquisition card in the computer.
INTRODUCTION

This section provides all the information for installing and running software LVDAM-EMS. The subsection titled LVDAM-EMS INSTALLATION describes how to install the LVDAM-EMS software in the hard disk of your computer. The subsection titled RUNNING LVDAM-EMS explains how to run LVDAM-EMS.

LVDAM-EMS INSTALLATION

☐ 1. Make a copy of the Lab-Volt Data Acquisition and Management for ElectroMechanical Systems (LVDAM-EMS) installation disks before performing the installation. Keep the original LVDAM-EMS installation disks in a safe place and use the copy disks to install LVDAM-EMS.

☐ 2. Insert LVDAM-EMS Installation disk 1 into drive A.

Note: The LVDAM-EMS installation can be carried out using either drive A or B. If you use drive B, replace drive A with drive B in the procedure.

☐ 3. Choose the Run... command in the File menu of Windows™ Program Manager or in the Start menu of Windows™95.

☐ 4. Type "A:SETUP" in the Command Line then click the OK button (or press the ENTER key of the keyboard).

☐ 5. Follow the instructions on the computer screen to complete the LVDAM-EMS installation.

Note: If problems occur while installing LVDAM-EMS, disable all terminate-and-stay resident programs (anti-virus, screen saver, etc.) and redo the installation.
LVDAM-EMS Software
Installation Procedure

☐ 6. The LVDAM-EMS software installation is now completed.

RUNNING LVDAM-EMS

LVDAM-EMS can run in one of the following three operating modes: acquisition, simulation, and virtuality. The following subsections explain how to run LVDAM-EMS in each of these three operating modes.

Running LVDAM-EMS in the Acquisition Mode

In the Acquisition mode, the parameters measured by LVDAM-EMS come from electric signals injected to the inputs of the Data Acquisition Interface (DAI) module. This module is connected through a cable to the data acquisition card installed in your computer. To set LVDAM-EMS so that it runs in the acquisition mode, carry out the following procedure:

☐ 1. Make sure the DAI module is connected to the data acquisition card installed in the computer.

☐ 2. Start one of the following LVDAM-EMS applications: Metering, Oscilloscope, Phasor Analyzer or Harmonic Analyzer. The entry window of LVDAM-EMS should appear on the computer screen.

Click the Acquisition button in the LVDAM-EMS entry window to select the acquisition mode of operation. If no message box appears, choose the LVDAM-EMS Setup command in the Options menu to open the LVDAM-EMS Setup window, then go to step 5 of this procedure. Otherwise, go to step 3.

☐ 3. The message box indicates that there is no data acquisition card at the specified address. Click the OK button to close the message box and open the LVDAM-EMS Setup window.

☐ 4. In the Preferences folder of the LVDAM-EMS Setup window, select the address in the Acquisition Card Base Address list which corresponds to the address set on the data acquisition card.
LVDAM-EMS Software
Installation Procedure

Note: The default base address of data acquisition card PCL-711B used in the Model 9061 Data Acquisition Interface is 220H. Similarly, the default base address of data acquisition card ACL-8112PG used in the Model 9062 Data Acquisition Interface is 230H. The base address in the Acquisition Card Base Address list must be identical to that set on the data acquisition card. Refer to the Data Acquisition Interface instruction manual for more information about the data acquisition card base address.

☐  5. In the Preferences folder of the LVDAM-EMS Setup window, select the option in the Network (Voltage/Frequency) list that corresponds to the voltage and frequency of your local ac power network.

Note: The Preferences folder of the LVDAM-EMS Setup window allows several other settings, such as the language, the system of units, the pop-up help status (enabled or disabled), etc. to be modified. You can verify whether or not these settings are as desired, and make changes if necessary.

☐  6. Click the Apply button to apply the settings made in the LVDAM-EMS Setup window to this work session only. On the other hand, click the Save button if you wish to apply these settings to this work session and save them as the default settings. The default settings are used whenever LVDAM-EMS is started, that is, whenever a first LVDAM-EMS application is started.

☐  7. Click the OK button to close the LVDAM-EMS Setup window.

☐  8. LVDAM-EMS is now running in the acquisition mode. Refer to the other sections of this manual and the LVDAM-EMS Help to obtain information on the data acquisition interface as well as on how to use the LVDAM-EMS system.

Running LVDAM-EMS in the Simulation Mode

In the Simulation mode, the parameters measured by LVDAM-EMS come from simulated input parameters, and thereby, no DAI module nor data acquisition card is required. To run LVDAM-EMS in the simulation mode, carry out the following procedure:

☐  1. Start one of the following LVDAM-EMS applications: Metering, Oscilloscope, Phasor Analyzer or Harmonic Analyzer. The entry window of LVDAM-EMS should appear on the computer screen.
LVDAM-EMS Software
Installation Procedure

Click the Simulation button in the LVDAM-EMS entry window to select the simulation mode of operation.

☐ 2. LVDAM-EMS is now running in the simulation mode. Refer to the other sections of this manual and the LVDAM-EMS Help to obtain information on how to use LVDAM-EMS. See Simulation Parameters in the LVDAM-EMS Help or Section 4 of this manual to know how to change the simulated input parameters.

Running LVDAM-EMS in the Virtuality Mode

In the Virtuality mode, the parameters measured by LVDAM-EMS comes from a virtual electromechanical system simulated using the Lab-Volt SIMulation software of the ElectroMechanical System (LVSIM®-EMS). The LVSIM®-EMS software automatically sets the operating mode to virtuality when starting LVDAM-EMS. It also resets the operating mode to its original value when closing LVDAM-EMS. To run LVDAM-EMS in the virtuality mode, carry out the following procedure:

☐ 1. Start the LVSIM®-EMS software. The LVSIM®-EMS entry window should appear on the computer screen. Click the OK button to close this window.

☐ 2. Set up a virtual electromechanical system using LVSIM®-EMS. Refer to the LVSIM®-EMS Help to obtain information on how to setup and interconnect a virtual electromechanical system.

Note: LVDAM-EMS can run in the virtuality mode even when there is no equipment setup in LVSIM®-EMS. To do so, go to the next step of this procedure without setting up an electromechanical system in LVSIM®-EMS.

☐ 3. Start one of the LVDAM-EMS application from software LVSIM®-EMS. Refer to the LVSIM®-EMS Help to know how to start a LVDAM-EMS application from LVSIM®-EMS.

☐ 4. LVDAM-EMS is now running in the virtuality mode and is ready for measuring parameters in any virtual electromechanical system implemented using LVSIM®-EMS. Refer to the other sections of this manual and the LVDAM-EMS Help to obtain information on how to use LVDAM-EMS.
LVDAM-EMS Software

INTRODUCTION

This section describes in detail software LVDAM-EMS. It contains all topics available in the help system of software LVDAM-EMS. Note that all texts printed in italics correspond to topic titles. You can refer to the following list of topics to quickly locate a particular topic in this section.

Analog Output Settings ................................................. 4-84
Analog Outputs .......................................................... 4-86
Auto Record Settings ................................................... 4-19
Auxiliary Analog Input Settings ...................................... 4-85
Auxiliary Analog Inputs .................................................. 4-86

Clipping Indication ...................................................... 4-31
Colors (Graph) ............................................................ 4-41
Colors (Harmonic Analyzer) ............................................ 4-77
Colors (Metering) ......................................................... 4-20
Colors (Oscilloscope) ..................................................... 4-54
Colors (Phasor Analyzer) ............................................... 4-64
Context-Sensitive Menu Commands (Graph) ..................... 4-41
Context-Sensitive Menu Commands (Metering) .................. 4-12

Data Labels .............................................................. 4-35
Data Menu Commands (Metering) ..................................... 4-9
Data Table ................................................................. 4-31
Data Table Toolbar ....................................................... 4-36
Display Refresh (Harmonic Analyzer) ............................. 4-72
Display Refresh (Oscilloscope) ....................................... 4-49
Display Refresh (Phasor Analyzer) .................................. 4-62

Edit Menu Commands (Data Table) ................................. 4-33
Edit Menu Commands (Graph) ........................................ 4-38
Editing Data ............................................................... 4-37

File Menu Commands (Data Table) ................................. 4-32
File Menu Commands (Graph) ......................................... 4-38
File Menu Commands (Harmonic Analyzer) ....................... 4-66
File Menu Commands (Metering) .................................... 4-6
File Menu Commands (Oscilloscope) ............................... 4-43
File Menu Commands (Phasor Analyzer) ........................... 4-58
File Types ................................................................. 4-87
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph</td>
<td>4-37</td>
</tr>
<tr>
<td>Graph Toolbar</td>
<td>4-42</td>
</tr>
<tr>
<td>Harmonic Analyzer</td>
<td>4-65</td>
</tr>
<tr>
<td>Harmonic Analyzer Cursors</td>
<td>4-75</td>
</tr>
<tr>
<td>Harmonic Analyzer Settings</td>
<td>4-72</td>
</tr>
<tr>
<td>Harmonic Analyzer Status Bar</td>
<td>4-71</td>
</tr>
<tr>
<td>Harmonic Analyzer Toolbar</td>
<td>4-71</td>
</tr>
<tr>
<td>Harmonic Distortion Display</td>
<td>4-77</td>
</tr>
<tr>
<td>Help Menu Commands (Data Table)</td>
<td>4-35</td>
</tr>
<tr>
<td>Help Menu Commands (Graph)</td>
<td>4-40</td>
</tr>
<tr>
<td>Help Menu Commands (Harmonic Analyzer)</td>
<td>4-70</td>
</tr>
<tr>
<td>Help Menu Commands (Metering)</td>
<td>4-11</td>
</tr>
<tr>
<td>Help Menu Commands (Oscilloscope)</td>
<td>4-48</td>
</tr>
<tr>
<td>Help Menu Commands (Phasor Analyzer)</td>
<td>4-61</td>
</tr>
<tr>
<td>Interface</td>
<td>4-83</td>
</tr>
<tr>
<td>LVDAM-EMS</td>
<td>4-5</td>
</tr>
<tr>
<td>LVDAM-EMS Setup</td>
<td>4-79</td>
</tr>
<tr>
<td>LVSIM®-EMS</td>
<td>4-82</td>
</tr>
<tr>
<td>Memory</td>
<td>4-54</td>
</tr>
<tr>
<td>Menus (Data Table)</td>
<td>4-32</td>
</tr>
<tr>
<td>Menus (Graph)</td>
<td>4-37</td>
</tr>
<tr>
<td>Menus (Harmonic Analyzer)</td>
<td>4-66</td>
</tr>
<tr>
<td>Menus (Metering)</td>
<td>4-6</td>
</tr>
<tr>
<td>Menus (Oscilloscope)</td>
<td>4-43</td>
</tr>
<tr>
<td>Menus (Phasor Analyzer)</td>
<td>4-58</td>
</tr>
<tr>
<td>Meter Layout</td>
<td>4-19</td>
</tr>
<tr>
<td>Meter Operating Modes</td>
<td>4-16</td>
</tr>
<tr>
<td>Meter Settings</td>
<td>4-14</td>
</tr>
<tr>
<td>Metering</td>
<td>4-5</td>
</tr>
<tr>
<td>Metering Status Bar</td>
<td>4-13</td>
</tr>
<tr>
<td>Metering Toolbar</td>
<td>4-13</td>
</tr>
<tr>
<td>Offsets</td>
<td>4-82</td>
</tr>
<tr>
<td>Operating Mode</td>
<td>4-81</td>
</tr>
<tr>
<td>Options Menu Commands (Data Table)</td>
<td>4-34</td>
</tr>
<tr>
<td>Options Menu Commands (Graph)</td>
<td>4-39</td>
</tr>
<tr>
<td>Options Menu Commands (Harmonic Analyzer)</td>
<td>4-68</td>
</tr>
<tr>
<td>Options Menu Commands (Metering)</td>
<td>4-10</td>
</tr>
<tr>
<td>Options Menu Commands (Oscilloscope)</td>
<td>4-46</td>
</tr>
<tr>
<td>Options Menu Commands (Phasor Analyzer)</td>
<td>4-60</td>
</tr>
<tr>
<td>Oscilloscope</td>
<td>4-43</td>
</tr>
<tr>
<td>Oscilloscope Status Bar</td>
<td>4-49</td>
</tr>
<tr>
<td>Oscilloscope Toolbar</td>
<td>4-48</td>
</tr>
<tr>
<td>Overrange Indication</td>
<td>4-31</td>
</tr>
<tr>
<td>Phasor Analyzer</td>
<td>4-57</td>
</tr>
<tr>
<td>Phasor Analyzer Status Bar</td>
<td>4-62</td>
</tr>
<tr>
<td>Phasor Analyzer Toolbar</td>
<td>4-62</td>
</tr>
</tbody>
</table>
LVDAM-EMS Software

Phasor Data .................................................. 4-64
Phasor Selection and Scale Setting ...................... 4-63
Preferences ..................................................... 4-79

Reference Phasor Selection .................................. 4-63

Selecting Data ................................................ 4-36
Shortcuts to Meter Settings ................................ 4-17
Simulation Parameters .................................... 4-82
Spectrum Analyzer Cursors ................................ 4-76
Spectrum Analyzer Settings ................................ 4-74

Technical Information about Metering .................... 4-21
Technical Information about Parameter Sampling (Metering) ........................................ 4-21
Technical Information about Parameter Sampling (Oscilloscope) ...................................... 4-55
Technical Information about the Electrical Power Meters ...................................... 4-23
Technical Information about the Harmonic Analyzer ............................................. 4-77
Technical Information about the Mechanical Power Meter .................................. 4-23
Technical Information about the Oscilloscope ................................................ 4-55
Technical Information about the Phasor Analyzer ............................................... 4-65
Technical Information about the Programmable Meter Angle Functions ....................... 4-31
Technical Information about the Programmable Meter Efficiency Functions .................. 4-27
Technical Information about the Programmable Meter Electrical and Mechanical Power Functions ........................................... 4-25
Technical Information about the Programmable Meter Energy Functions ....................... 4-29
Technical Information about the Programmable Meter Frequency Functions .................... 4-29
Technical Information about the Programmable Meter Functions ................................ 4-23
Technical Information about the Programmable Meter Impedance Functions ...................... 4-28
Technical Information about the Programmable Meter Power Factor Functions ................. 4-28
Technical Information about the Programmable Meter Ratio Functions .......................... 4-30
Technical Information about the Programmable Meter Torque and Speed Functions .......... 4-30
Technical Information about the Programmable Meter Voltage and Current Functions ........ 4-24
Technical Information about the Torque and Speed Meters .................................... 4-22
Technical Information about the Voltmeters and Ammeters .................................... 4-22
Technical Information about Time Base Accuracy ................................................ 4-55
Technical Information about Trigger Operation ................................................... 4-56
Technical Information about Waveform Data Calculation ......................................... 4-57

Time Base ........................................................ 4-50
Tools Menu Commands (Data Table) ......................... 4-35
Tools Menu Commands (Graph) ................................ 4-40
Tools Menu Commands (Harmonic Analyzer) .................... 4-70
Tools Menu Commands (Metering) .................................. 4-11
Tools Menu Commands (Oscilloscope) .................................. 4-47
Tools Menu Commands (Phasor Analyzer) ......................... 4-61
Trigger Controls ............................................... 4-51
LV DAM-EMS Software

Vertical Controls .................................................. 4-50
View Menu Commands (Data Table) ............................ 4-34
View Menu Commands (Graph) ................................. 4-38
View Menu Commands (Harmonic Analyzer) .................. 4-67
View Menu Commands (Metering) .............................. 4-8
View Menu Commands (Oscilloscope) ......................... 4-45
View Menu Commands (Phasor Analyzer) ..................... 4-59

Waveform Data ....................................................... 4-53

X- and Y-Axis Parameter Selection ............................ 4-42
X-Y Mode ............................................................ 4-53
LVDAM-EMS Software

LVDAM-EMS

The Lab-Volt Data Acquisition and Management (LVDAM-EMS) software is a powerful tool for the hands-on study of electrical power technology and power electronics. The software is a Windows™ program consisting of four separate applications which are called Metering, Oscilloscope, Phasor Analyzer, and Harmonic Analyzer. These applications form a complete set of instruments consisting of a panel of meters (voltmeters, ammeters, power meters, programmable meters, etc.), an eight-channel oscilloscope, a six-channel phasor analyzer, and a harmonic analyzer. LVDAM-EMS also allows external devices to be controlled through analog outputs.

You can refer to one of the following topics to obtain information on one of the instruments or to know how to modify the LVDAM-EMS setup.

- Metering
- Oscilloscope
- Phasor Analyzer
- Harmonic Analyzer
- Analog Outputs
- LVDAM-EMS Setup

Metering

The Metering application in LVDAM-EMS allows measurements of electrical and mechanical parameters in electromechanical systems as well as in power electronics circuits. It contains voltmeters (E1, E2, E3), ammeters (I1, I2, I3), electrical power meters (PQS1, PQS2, PQS3), programmable meters (A, B, C, D, E, and F), a torque meter (T), a speed meter (N), and a mechanical power meter (Pm). All meter settings, that is, the meter range, the meter status (on or off), etc., can be changed according to your needs. Values measured with the various meters can be recorded in a data table to plot graphs.

You can refer to one of the following topics to obtain information on the menus, the toolbar, the status bar, changing any of the meter settings, the meter operation,
LVDAM-EMS Software

how to change the arrangement of the meters in the Metering window (Layout), how to use the data table or how to plot graphs.

Menus
Metering Toolbar
Metering Status Bar
Meter Settings
Shortcuts to Meter Settings
Auto Record Settings
Meter Layout
Technical Information about Metering
Overrange Indication
Clipping Indication
Data Table
Graph

Menus (Metering)

You can refer to one of the following topics to obtain information on the commands in one of the menus of the Metering application.

File Menu Commands
View Menu Commands
Data Menu Commands
Options Menu Commands
Tools Menu Commands
Help Menu Commands
Context-Sensitive Menu Commands

File Menu Commands (Metering)

Open Workspace...

Opens a Workspace file (filename.dai). Opening a Workspace file allows you to recover an LVDAM-EMS environment that has been saved previously. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the current LVDAM-EMS environment in a Workspace file. See File Types to obtain a detailed description of the Workspace and Data Table files.
LVDAM-EMS Software

Save Workspace, Save Workspace As...

The Save Workspace and Save Workspace as... commands save the current LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Print...

Sends the Metering window to the printer. Note that the menu bar, toolbar, and status bar in the Metering window are not sent to the printer.

The Print dialog box appears before the Metering window is sent to the printer. This box allows the print setup and options to be modified before printing. The Metering window is effectively sent to the printer after the OK button in the Print dialog box is clicked.

Exit

Closes the Metering application. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Note that the current configuration (meter settings) of the Metering application is kept in memory when exiting while another LVDAM-EMS application is open.

When exiting the Metering application last at the end of a work session where the LVDAM-EMS environment has been changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application.

See File Types to obtain a detailed description of the Workspace and Data Table files.

Exit LVDAM-EMS

Closes all currently running applications of LVDAM-EMS. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace and Data Table files.
View Menu Commands (Metering)

Refresh

Refreshes the value indicated by each of the meters in the Metering window. Note that when this command is performed while the values indicated by the meters are refreshed at regular time intervals (continuous refresh), the current refreshing cycle is completed, then the continuous refresh of the meters is stopped. See Continuous Refresh in this topic for additional information.

Continuous Refresh

Determines whether the values indicated by the meters in the Metering window are automatically refreshed at regular time intervals or refreshed manually using the Refresh button or the Refresh Command in the View menu. A check mark appears beside the Continuous Refresh command in the View menu when continuous refresh is selected.

Auto Sizing

Determines whether or not automatic sizing of the Metering window is used. The dimensions of the Metering window on the computer screen are set automatically when the auto sizing function is used. A check mark appears beside the Auto Sizing command in the View menu when automatic sizing of the Metering window is selected.

Always on Top

Keeps the Metering application on top of other open applications. A check mark appears beside the Always on Top command in the View menu when this function is selected.

Menu Bar

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.

Toolbar

Determines whether or not the toolbar is displayed in the Metering window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.
LVDAM-EMS Software

Status Bar

Determines whether or not the status bar is displayed in the Metering window. A check mark appears beside the Status Bar command in the View menu when the status bar is displayed.

Data Menu Commands (Metering)

Record

Reads the values indicated by the meters in the Metering window and records these values in the Data Table at the row indicated by the row pointer. The row pointer is the number displayed next to the Record Data button in the Metering window. Note that the values indicated by the meters cannot be recorded if a row of data is already recorded in the Data Table and the settings of certain meters have changed since that data row has been recorded. This ensures that data recorded in each column of the Data Table are all of the same nature.

Auto Record

The Auto Record command allows selection between manual and automatic recording of the values indicated by the meters in the Metering window. A check mark appears beside the Auto Record command when automatic data recording is selected.

When manual data recording is selected, a row of data is recorded in the Data Table every time you click the Record Data button or choose the Record command in the Data menu.

When automatic data recording is selected, rows of data are recorded automatically according to settings made in the Auto Record Settings dialog box. Note that the Record Data button is disabled when automatic data recording is selected. See Auto Record Settings in this topic for additional information about automatic data recording.

Auto Record Settings...

Opens the Auto Record Settings dialog box. This box allows changing the settings that define how automatic data recording is performed. See Auto Record Settings to obtain information on the Auto Record Settings.

Clear Data Table

Clears all data in the Data Table. Note that a dialog box appears asking for a confirmation before data is effectively cleared from the Data Table.
Options Menu Commands (Metering)

Layout...

Opens the Layout dialog box. This box allows you to select and modify a meter layout. A meter layout is the arrangement of the meters in the Metering window. Four meter layouts are available. See Meter Layout to obtain additional information.

Meter Settings...

Opens the Meter Settings dialog box. This box allows the various settings of each meter in the Metering window to be changed. See Meter Settings to know how to change meter settings.

Colors...

Opens the Colors dialog box. This box allows the color associated with each meter in the Metering window to be changed. See Colors to know how to change the color associated with each meter.

Default Configuration

Restores the current configuration (meter settings) of the Metering application to the default configuration.

Sampling Window

Selects between the normal and extended sampling windows. The sampling window is the time interval over which sampling of the measured parameters is performed to obtain the data used to calculate the values indicated by the meters in the Metering window.

The normal sampling window, whose duration is equal to that of one cycle of the AC network voltage (1/60 s or 1/50 s), allows accurate measurement of fixed parameters (pure DC voltages and currents, torque, speed, etc.) as well as sine-wave signals at the AC network frequency and multiples of this frequency up to 400 Hz. The measurement accuracy and stability are significantly affected when measuring non-sinusoidal signals using the normal sampling window.

The extended sampling window allows accurate measurement of fixed parameters (pure DC voltages and currents, torque, speed, etc.) as well as any non-sinusoidal signal whose frequency components are between 6 Hz and 400 Hz. However, using the extended sampling window may affect mouse operation when the values indicated by the meters in the Metering window are automatically refreshed at regular time intervals. See View Menu Commands for additional information on continuous refresh.
LVDAM-EMS Software

See Technical Information about Parameter Sampling for additional information on the sampling window.

**LVDAM-EMS**

Opens the LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings dialog box. These dialog boxes allow you to modify the settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings to obtain additional information.

**Tools Menu Commands (Metering)**

Each command in the Tools menu allows opening one of the following applications or windows, or switching to one of these applications or windows if it is already open.

You can refer to one of the following topics to obtain information on one of the applications or windows.

- Oscilloscope
- Phasor Analyzer
- Harmonic Analyzer
- Analog Outputs
- Data Table
- Graph

Calculator is a Microsoft® Windows™ application that includes both a standard and scientific calculator. Refer to the Calculator Help to obtain information on how to use Calculator.

Visual Tour is a Lab-Volt Windows™ application that provides access to a library of Visual Tour presentations which summarize each laboratory exercise in the electrical power technology courseware.

**Help Menu Commands (Metering)**

**Contents**

Enters the LVDAM-EMS help.
Search for Help on...

Opens a dialog box which allows help on a particular topic to be searched. Available topics are listed in alphabetical order.

About Metering...

Opens a window which provides general information about the Metering application.

Context-Sensitive Menu Commands (Metering)

A context-sensitive menu is available in the Metering window. The context-sensitive menu can be displayed by clicking the right mouse button when the mouse pointer is on one of the meters. The commands available in the context-sensitive menu are described below.

Layout...

See Layout... in Options Menu Commands (Metering) for a description of this command.

Meter Settings...

See Meter Settings... in Options Menu Commands (Metering) for a description of this command.

Colors...

See Colors... in Options Menu Commands (Metering) for a description of this command.

Aux. Analog Input Settings...

Opens the Auxiliary Analog Input Settings dialog box. This dialog box allows you to modify the settings of the auxiliary analog inputs. See Auxiliary Analog Input Settings to obtain additional information.
LVDAM-EMS Software

**Metering Toolbar**

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Opening a Workspace File
- Saving the LVDAM-EMS Environment in a Workspace File
- Printing the Metering Window
- Refreshing the Meters
- Continuously Refreshing the Meters
- Opening the *Meter Settings* dialog box
- Recording Data in Table
- Opening the *Data Table* window
- Opening the *Graph* window
- Opening the *Oscilloscope* application
- Opening the *Phasor Analyzer* application
- Opening the *Harmonic Analyzer* application
- Opening the *LVDAM-EMS Setup* dialog box
- Opening the Visual Tour application

**Metering Status Bar**

The Metering status bar is located at the bottom of the Metering window.

The first field in the status bar indicates the number of data rows recorded in the Data Table.

The second field indicates the mode in which LVDAM-EMS is operating. See *Operating Mode* for additional information.

The third field indicates the voltage and frequency of the AC power network. See Network in *Preferences* for additional information.
The fourth field indicates whether the normal or extended sampling window is used to acquire the data required to calculate the values displayed by the meters in the Metering window. See Sampling Window in Options Menu Commands (Metering) for additional information.

**Meter Settings**

The settings of the various meters in the Metering window can be changed through the Meter Settings dialog box. Shortcuts in the Metering window are also available for changing the meter settings. See Shortcuts to Meter Settings for additional information. The various items in the Meter Settings dialog box are described in this topic.

**Meter**

In the Meter Settings dialog box, meter settings can be changed one meter at a time. The Meter list allows the selection of the meter whose settings will be changed.

**Color**

A color is associated with each meter in the Metering window. The Color list allows the color associated with the meter selected in the Meter list to be changed. To do so, click the Color list button to display the color palette, then select the desired color by clicking the corresponding color in the palette.

**Type and Input / Function**

Options appear in the Type and Input / Function lists when a programmable meter (meters A to F) is selected in the Meter list. The Type list allows selecting the type of parameter (voltage, power, impedance, frequency, energy, etc.) that is measured by the programmable meter.

Once the type of parameter has been selected, the Input / Function list indicates the functions and/or auxiliary analog inputs which are available for measuring this type of parameter. The desired function or auxiliary analog input is selected by clicking an option in the Input / Function list. See Technical Information about the Programmable Meter Functions to obtain information on the various meter functions. See Auxiliary Analog Inputs to obtain information on the analog inputs (AI-1 to AI-8).
LVDAM-EMS Software

Label

In the Metering window, there is a label above the display of each meter. The Label box allows editing the label of the meter selected in the Meter list. Note that the label of each meter can also be edited directly in the Metering window.

Mode

The Mode list allows selecting the operating mode of the meter selected in the Meter list. The available modes depend on the type of parameter (voltage, current, power, impedance, power factor, torque, etc.) that is measured with the meter. See Meter Operating Modes to obtain additional information about the operating modes available for each of the various types of meter.

Display

Each meter in the Metering window can have a digital-type or analog-type display. The display type of the meter selected in the Meter list is determined by clicking one of the two Display option buttons.

Scale

When the Analog Display option button is selected, the Scale list allows selecting the scale of the meter selected in the Meter list.

Meter Status (On or Off)

The status (on or off) of the meter selected in the Meter list can be changed by clicking the ON check box. A check mark appears in the ON check box to confirm that the meter is turned on. Note that a programmable meter cannot be turned on as long as the meter definition (nature of the measured parameter, input(s), function) has not been determined by selecting an option in the Type and Input / Function lists.

Analog Meter Zero Location

In the Metering window, the zero on the analog-type display meter may be located in the middle or on the left side of the scale. When the Analog Display option button is selected, the zero location (middle or left) of the meter selected in the Meter list can be changed by clicking the 0 Center check box. A check mark appears in the 0 Center check box to confirm that the zero is located in the middle of the scale.
Command Buttons

Clicking the Aux. Analog Input Settings... button opens the Auxiliary Analog Input Settings dialog box. This box allows the settings of the auxiliary analog inputs to be changed. See Auxiliary Analog Input Settings to obtain additional information.

Clicking the Apply button applies the settings currently indicated in the Meter Settings dialog box to the meter selected in the Meter list.

Clicking the Cancel button returns to the Metering window without changing the settings of the meter selected in the Meter list.

Clicking the OK button applies the settings currently indicated in the Meter Settings dialog box to the meter selected in the Meter list and returns to the Metering window.

Clicking the Help button provides help on the Meter Settings dialog box.

Meter Operating Modes

There are two or three operating modes available for several of the meters in the Metering window. The modes which are available for any meter depend on the type of parameter (voltage, current, power, impedance, torque, etc.) that is measured with the meter. The operating modes available for each of the various types of meters are listed below.

Voltage and Current Meters (Voltmeters and Ammeters)

Two operating modes are available: AC and DC. In the AC mode, the root-mean-square (rms) value of the parameter is measured. In the DC mode, the average value of the parameter is measured. See Technical Information about the Voltmeters and Ammeters for additional information.

Symmetrical Component Meters

Three operating modes are available: P, N, and Z. In the P mode, the positive sequence voltage (or current) related to a three-phase power system is indicated. In the N mode, the negative sequence voltage (or current) is indicated. In the Z mode, the zero sequence voltage (or current) is indicated. See Voltage and Current in Technical Information about the Programmable Meter Functions for additional information.
LVDAM-EMS Software

**Electrical Power Meters**

Three operating modes are available: S, P, and Q. In the S mode, apparent power is measured. In the P mode, active power is measured. In the Q mode, reactive power is measured. See *Technical Information about the Electrical Power Meters* for additional information.

**Impedance Meters**

Three operating modes are available: R, X, and Z. In the R mode, resistance is measured. In the X mode, reactance is measured. In the Z mode, impedance is measured. See Impedance in *Technical Information about the Programmable Meter Functions* for additional information.

**Torque and Mechanical Power Meters**

Two operating modes are available: NC and C. In the NC (non-corrected) mode, the torque measured by the torque measurement mechanism, or the mechanical power calculated using this torque, is indicated. In the C (corrected) mode, the measured torque is corrected to compensate for errors due to friction in the torque measurement mechanism. The corrected torque, or the mechanical power calculated using the corrected torque, is indicated. See *Technical Information about the Torque and Speed Meters* for additional information.

Note that no operating mode is available for the following types of meters:

- Efficiency Meters
- Power Factor Meters
- Frequency Meters
- Energy Meters
- Speed Meters (Tachometers)
- Ratio Meters
- Angle Meters

**Shortcuts to Meter Settings**

The settings of the various meters in the Metering window can be changed using the *Meter Settings* dialog box. However, most of the meter settings can also be changed directly from the Metering window using shortcuts. These shortcuts consist of 3-D zones (usually boxes) on each meter in the Metering window. Each of these zones can be clicked to modify a particular meter setting. Available shortcuts are briefly described in the following figure and paragraphs.
Meter Identification Tag

Clicking the meter identification tag changes the on/off status of the meter. Note that a programmable meter with no function selected remains off when its identification tag is clicked.

Digital Display

Clicking in the digital display of a meter changes the meter display type (analog or digital). Note that the display type of a programmable meter with no function selected does not change when the digital display of this meter is clicked.

Analog Display

On the meters with an analog-type display, clicking anywhere in the analog display changes the zero location (middle or left).

Lower Left Corner Zone

On the voltimeters (E1, E2, E3), the ammeters (I1, I2, I3), and the programmable meters (A, B, C, D, E, F) used as a voltmeter or an ammeter, clicking the mode indicated in the lower left corner changes the meter mode (AC or DC).

On the electrical power meters (PQS1, PQS2, PQS3) and the programmable meters used to measure electrical power, clicking the lower left corner box changes the type of power (active, reactive or apparent power) measured by the meter.

On the torque meter T, the mechanical power meter Pm, and the programmable meters used to measure torque or mechanical power, clicking the lower left corner box changes the status (enabled or disabled) of the torque correction function. The letter C is displayed in the lower left corner box when the torque correction function is enabled. Conversely, when the torque correction function is disabled, "NC" is displayed in the lower left corner box. The torque correction function is required to compensate for the error caused by friction within the torque measurement mechanism.
LVDAM-EMS Software

On the programmable meters used as symmetrical component meters (PNZ), clicking the lower left corner box changes the symmetrical component (positive, negative or zero sequence component) measured by the meter.

On the programmable meters used as impedance meters (RXZ), clicking the lower left corner box changes the component of impedance (resistance, reactance or modulus of the impedance) measured by the meter.

On the programmable meters used as energy meters (W), clicking the lower left corner box resets the meter to zero.

Meter Range

On the meters with an analog-type display, clicking the range indicated in the lower right corner changes the meter range.

Auto Record Settings

The Auto Record Settings dialog box contains the settings that define how automatic recording of the values indicated by the meters in the Metering window is performed. These settings are: the measured parameter (for example voltage E1) which is used to control automatic data recording, the values of that parameter at which data recording starts and ends (values in the From and To fields of the dialog box), and the increment (or decrement) of that parameter between each data recording (value in the Step field of the dialog box).

The measured parameter used to control automatic data recording is selected through the Parameter list in the dialog box while the other values governing automatic data recording can be edited using the keyboard.

Clicking the OK button closes the dialog box and updates the auto record settings.

Clicking the Cancel button returns to the Metering window without changing the auto record settings.

Clicking the Help button provides help on the Auto Record Settings dialog box.

See Auto Record in Data Menu Commands to know how to select automatic data recording.

Meter Layout

The Layout dialog box allows you to select the layout of the meters in the Metering window. It also allows a meter layout to be edited by changing the number of meters and modifying the arrangement of the meters. The Layout dialog box is
opened by choosing the Layout... command in the Options menu or context-sensitive menu (right mouse button).

In the Layout dialog box, the Layout list allows selection of one of the meter layouts available. The array of boxes in the Layout dialog box shows the actual arrangement of the meters in the selected layout. Each box in the array corresponds to a meter. The meters shown in red in the meter layout will be displayed in the Metering window.

The number of meters in the selected meter layout can be modified by changing the number of columns and rows. The number of columns can be increased and decreased by clicking the up and down buttons beside the Number of Columns display. Similarly, the number of rows can be increased and decreased by clicking the up and down buttons beside the Number of Rows display. Any meter can be moved by dragging the corresponding box in the array so that it overlaps the box where you wish to position the meter. The meter in the overlapped box is displaced to the former position of the other meter.

Clicking the Default button changes the currently-selected meter layout to the default all meters arrangement.

Clicking the OK button applies the currently-selected meter layout to the Metering window, saves all changes made to the meter layouts, and returns to the Metering window.

Clicking the Cancel button returns to the Metering window without taking into account any of the selections and changes made in the Layout dialog box.

Clicking the Help button provides help on the Layout dialog box.

Colors (Metering)

The Colors dialog box allows the color associated with each meter in the Metering window to be changed. To change the color associated with a meter, select a meter in the Meter list, then select the desired color by clicking the corresponding color in the color palette.

Clicking the Default button replaces the colors currently selected in the Colors dialog box with the default colors associated with the meters in the Metering window. The default colors are the original colors associated with the meters, in the default configuration of the Metering application.

Clicking the OK button applies the colors currently selected in the Colors dialog box to the meters in the Metering window and returns to the Metering window.

Clicking the Cancel button returns to the Metering window without changing the colors associated with the meters in the Metering window.
LVDAM-EMS Software

Clicking the Apply button applies the colors currently selected in the Colors dialog box to the meters in the Metering window.

Clicking the Help button provides help on the Colors dialog box.

Technical Information about Metering

You can refer to one of the following topics to obtain technical information on the sampling of the parameters and the various meters in the Metering window.

- Technical Information about Parameter Sampling
- Technical Information about the Voltmeters and Ammeters
- Technical Information about the Torque and Speed Meters
- Technical Information about the Electrical Power Meters
- Technical Information about the Mechanical Power Meter
- Technical Information about the Programmable Meter Functions

Technical Information about Parameter Sampling (Metering)

Two combinations of interface module and data acquisition card can be used with LVDAM-EMS: 9061 / PCL-711B and 9062 / ACL-8112PG. The two interface modules (models 9061 and 9062) have the following basic inputs: three voltage inputs (E1, E2, E3), three current inputs (I1, I2, I3), a torque input (T), and a speed input (N). Interface module 9062 also has eight auxiliary analog inputs (AI-1 to AI-8). These are low-voltage inputs that can be used to measure various parameters through different types of sensors (voltage isolator, current isolator, tachogenerator, etc.). In both cases, the data acquisition card in the computer samples the parameters sensed with the interface module. The parameters are sampled the same way no matter what combination of interface module and data acquisition card is used.

When the normal sampling window is selected, the parameters are sampled at a frequency of 3.125 kHz when the AC network frequency is 60 Hz. The sampling frequency is 2.6 kHz when the AC network frequency is 50 Hz. The samples are used to calculate the values indicated by all meters in the Metering application. Every 52 samples, a new value is calculated for each parameter. Note that the time interval required to take 52 samples of each parameter is very close to the period corresponding to the AC network frequency. When a new value is available, it is displayed on the meters with an analog-type display. This allows a high refresh rate to be obtained when the continuous refresh mode is selected. For the meters with a digital-type display, the mean value of the values obtained every 52 samples is calculated over an interval of 0.5 seconds (0.5 s) and displayed. Therefore, the meters with a digital-type display are refreshed every 0.5 s when the continuous refresh mode is selected.
When the extended sampling window is selected, the parameters are sampled at a frequency of 3.125 kHz no matter what is the AC power network frequency. A new value is calculated for each parameter every 780 samples. This improves the performance of the meters because the values are calculated using data sampled over a long time interval, which is very close to 0.25 s. See Sampling Window in Options Menu Commands to obtain additional information on the sampling window.

Technical Information about the Voltmeters and Ammeters

Voltmeters E1, E2, and E3, and ammeters I1, I2, and I3 can operate in either the AC or DC mode. In the DC mode, the meter provides the mean value of the measured parameter. This value is obtained by calculating the mean value of the samples of the measured parameter. In the AC mode, the meter provides the root-mean-square (rms) value of the measured parameter. The rms value is obtained by squaring the samples of the measured parameter, calculating the mean value of the squared samples, and then calculating the square root of the mean value of the squared samples.

For the voltmeters and ammeters with a digital-type display, the voltage and current ranges are 400 V and 12 A when the AC network frequency is 60 Hz. On the other hand, when the AC network frequency is 50 Hz, the voltage and current ranges are 750 V and 6 A.

Technical Information about the Torque and Speed Meters

The torque and speed are obtained by calculating the mean value of the samples taken at the T and N hardware inputs, respectively. Note that the calculated torque value is expressed in N-m. This value is multiplied by 8.85 when the torque is indicated in lbf-in.

When the speed meter has a digital-type display, the speed range is 5000 r/min.

When the torque meter has a digital-type display, the torque range is 3.0 N-m.

The friction in the Lab-Volt torque measurement mechanism (Prime Mover / Dynamometer and timing belt) cannot be neglected. This causes an error on the measured torque. Fortunately, LVDAM-EMS provides a torque correction function. When this function is enabled, a typical curve of the friction torque caused by the Lab-Volt torque measurement mechanism as a function of speed is used to compensate for the error on the measured torque.
LVDAM-EMS Software

Technical Information about the Electrical Power Meters

Electrical power meters PQS1, PQS2, and PQS3 can measure apparent power (S), active power (P), and reactive power (Q).

Power meter PQS1 determines power using the voltage and current on hardware inputs E1 and I1. Similarly, power meters PQS2 and PQS3 use the voltage and current on hardware inputs E2 and I2, and E3 and I3, respectively. Furthermore, the operation of the electrical power meters is totally independent of the voltmeter and ammeter settings.

The apparent power is obtained by multiplying the rms values of the voltage and current. The rms values are calculated as in the AC mode of the voltmeters and ammeters.

The active power is obtained by multiplying the voltage and current values for each sample and then calculating the mean value of the voltage-current products.

The reactive power is obtained by shifting the phase of the current by 90 degrees, multiplying the voltage and phase-shifted current values for each sample, and then calculating the mean value of the voltage-current products. Note that reactive power measurement is accurate as long as the waveforms of the voltage and current are sinusoidal.

Technical Information about the Mechanical Power Meter

The mechanical power meter Pm uses the torque and speed to determine the mechanical power. The torque and speed are obtained by calculating the mean value of the samples taken at the T and N hardware inputs, respectively. Note that the operation of the mechanical power meter is totally independent of the settings of the torque and speed meters.

Technical Information about the Programmable Meter Functions

Programmable meters A, B, C, D, E, and F can be used as voltmeters, ammeters, torque meters, speed meters, power meters, efficiency meters, impedance meters, power factor meters, etc. This depends on the type of parameter and function selected for each programmable meter, using the Meter Settings dialog box.

You can refer to one of the following topics to obtain technical information on one of the various families of programmable meter functions.

Technical Information about the Programmable Meter Voltage and Current Functions
Technical Information about the Programmable Meter Voltage and Current Functions

The following functions are available for measuring voltage and current:

\[
\begin{align*}
E1 & \quad I1 \\
E2 & \quad I2 \\
E3 & \quad I3 \\
E1+E2 & \quad I1+I2 \\
E1+E3 & \quad I1+I3 \\
E2+E3 & \quad I2+I3 \\
E1+E2+E3 & \quad I1+I2+I3 \\
\text{Avg (E1,E2,E3)} & \quad \text{Avg (I1,I2,I3)} \\
\text{PNZ (E1,E2,E3)} & \quad \text{PNZ (I1,I2,I3)}
\end{align*}
\]

The voltage functions E1, E2, and E3 measure the mean or root-mean-square (rms) value of the voltages at inputs E1, E2, and E3, respectively. Operation is the same as that of voltmeters E1, E2, and E3.

The current functions I1, I2, and I3 measure the mean or root-mean-square (rms) value of the currents at inputs I1, I2, and I3, respectively. Operation is the same as that of ammeters I1, I2, and I3.

The voltage summing functions (E1+E2, E1+E2+E3, etc.) sum the voltages indicated in parentheses for each sample and then calculate the mean or rms value of the voltage sums depending on whether the programmable meter operates in the DC or AC mode. The current summing functions (I1+I3, I2+I3, etc.) sum the currents indicated in parentheses in the same manner as the voltage summing functions.

The voltage averaging function Avg (E1,E2,E3) calculates the average value of voltages E1, E2, and E3. The current averaging function Avg (I1,I2,I3) calculates the average value of currents I1, I2, I3. The mean or rms values of the voltages (or
LVDAM-EMS Software

currents) are used depending on whether the programmable meter operates in the DC or AC mode.

The symmetrical component function PNZ (E1,E2,E3) measures the positive, negative or zero sequence voltage related to a three-phase power system using voltages E1, E2, and E3. Similarly, the symmetrical component function PNZ (I1,I2,I3) measures the positive, negative or zero sequence current using currents I1, I2, and I3. The symmetrical component that is measured depends on the operating mode selected for the programmable meter. The positive sequence voltage is obtained by advancing the phase of voltages E2 and E3 by 120 and 240 degrees, respectively, summing voltage E1 and phase shifted voltages E2 and E3 for each sample, dividing the result of each voltage sum by three, and then calculating the rms value of the weighted voltage sums. The negative sequence voltage is obtained by delaying the phase of voltage E2 and E3 by 120 and 240 degrees, respectively, summing voltage E1 and phase shifted voltages E2 and E3 for each sample, dividing the result of each voltage sum by three, and then calculating the rms value of the weighted voltage sums. The zero sequence component is obtained by summing voltages E1, E2, and E3 for each sample, dividing the result of each voltage sum by three, and then calculating the rms value of the weighted voltage sums. The positive, negative, and zero sequence currents are calculated using the same methods.

When auxiliary analog inputs are configured to measure voltage, they are added to the voltage functions listed above. Similarly, when auxiliary analog inputs are configured to measure current, they are added to the current functions listed above. When an auxiliary analog input is selected for measuring either voltage or current, the mean or root-mean-square (rms) value of the parameter at this input is measured and multiplied by a conversion factor, which depends on the configuration of the analog input. See Auxiliary Analog Inputs to obtain information on the auxiliary analog inputs (Al-1 to Al-8).

All voltage and current functions use the same methods as voltmeters E1, E2, and E3 and ammeters I1, I2, and I3 to calculate the mean and rms values of voltages and currents. See Technical Information about the Voltmeters and Ammeters for additional information.

Technical Information about the Programmable Meter Electrical and Mechanical Power Functions

The following functions are available for measuring electrical and mechanical powers:

PQS1 (E1,I1)
PQS2 (E2,I2)
PQS3 (E3,I3)
PQS (E1,I2)
PQS (E1,I3)
PQS (E2,I1)
LVDAM-EMS Software

PQS (E3,I1)

PQS1+PQS2
PQS1+PQS2+PQS3

PQS1 (E1,I1) 3–
PQS2 (E2,I2) 3–
PQS3 (E3,I3) 3–

Pm (T,N)

The electrical power functions PQS1 (E1,I1), PQS2 (E2,I2), and PQS3 (E3,I3) are identical to the functions of electrical power meters PQS1, PQS2, and PQS3, respectively.

The electrical power functions PQS (E1,I2), PQS (E1,I3), PQS (E2,I1), and PQS (E3,I1) measure active power (P), reactive power (Q) or apparent power (S) depending on the operating mode selected for the programmable meter. Power is calculated with the parameters indicated in parentheses.

The electrical power summing functions PQS1+PQS2 and PQS1+PQS2+PQS3 sum active (P), reactive (Q) or apparent (S) power depending on the operating mode selected for the programmable meter. Active power sums are obtained by calculating the algebraic sum of the active powers. Similarly, reactive power sums are obtained by calculating the algebraic sum of the reactive powers. Apparent power sums are obtained by calculating the vectorial sum of the active and reactive power sums. Note that the measurement of reactive power and apparent power is accurate as long as the waveforms of the voltages and currents are sinusoidal. Also note that the PQS1+PQS2 power summing function can be used to measure three-phase power using the two-wattmeter method, when inputs E1, E2, I1, and I2 of the data acquisition interface (D.A.I.) module are connected as shown in the following figure.
The electrical power functions PQS1 (E1,I1) 3-, PQS2 (E2,I2) 3-, and PQS3 (E3,I3) 3- measure three-phase power using the line-to-line voltage and line current indicated in parentheses. Active power (P), reactive power (Q) or apparent power (S) is measured depending on the operating mode selected for the programmable meter. Three-phase power is calculated in three steps. The line-to-line voltage is phase shifted by 30 degrees and divided by 1.73 to determine the corresponding line-to-neutral voltage. Single-phase power is then calculated using the line-to-neutral voltage and the line current. Finally, three-phase power is obtained by multiplying the single-phase power by 3. Note that accurate three-phase power measurement is obtained as long as the system is balanced. Also note that reactive power measurement is accurate as long as the waveforms of the voltage and current are sinusoidal.

Unless otherwise specified, all electrical power functions use the same methods as power meters PQS1, PQS2, and PQS3 to calculate the active, reactive, and apparent powers. See Technical Information about the Electrical Power Meters for additional information.

The mechanical power function Pm (T,N) is identical to the function of mechanical power meter Pm. See Technical Information about the Mechanical Power Meter for additional information.

Technical Information about the Programmable Meter Efficiency Functions

The following functions are available for measuring efficiency:

Pm/P1  
Pm/(P1+P2)  
P2/P1

Three efficiency functions are available. Active Powers P1 and P2 used to calculate efficiencies are obtained using voltage E1 and current I1, and voltage E2 and current I2, respectively. The method used to calculate active powers P1 and P2 is the same as that used to calculate active power in the electrical power meters. See Technical Information about the Electrical Power Meters for additional information.

The mechanical power is calculated using the torque and speed measured at inputs T and N, respectively, using the same method as mechanical power meter Pm. See Technical Information about the Mechanical Power Meter for additional information.
Technical Information about the Programmable Meter Impedance Functions

The following functions are available for measuring impedance:

RXZ (E1,I1)
RXZ (E2,I2)
RXZ (E3,I3)

The impedance functions RXZ (E1,I1), RXZ (E2,I2), and RXZ (E3,I3) measure resistance (R), reactance (X) or impedance (Z) depending on the operating mode selected for the programmable meter. The voltage and current indicated in the parentheses are used to calculate the resistance, the reactance or the impedance.

Technical Information about the Programmable Meter Power Factor Functions

The following functions are available for measuring power factor:

PF (E1,I1)
PF (E11,E12)

The power factor function PF (E1,I1) calculates the power factor of a single-phase AC power network using the voltage and current measured at inputs E1 and I1, respectively. The power factor is obtained by first calculating the active and apparent powers, and then dividing the active power by the apparent power.

The power factor function PF (E11,E12) calculates the power factor of a three-phase AC power network using line-to-line voltages measured at inputs E1 and E2, and line currents measured at inputs I1 and I2. The power factor is obtained by first calculating the three-phase active and apparent powers, and then dividing the active power by the apparent power. The method used to calculate the apparent power is the same as that used to calculate apparent power in the electrical power summing functions PQS1+PQS2 and PQS1+PQS2+PQS3. Note that accurate power factor measurement is obtained as long as the three-phase power system is balanced. Also note that power factor measurement is accurate as long as the waveforms of the voltages and currents are sinusoidal.

Unless otherwise specified, the methods used to calculate the active and apparent powers are the same as those used to calculate active and apparent powers in the electrical power meters. See Technical Information about the Electrical Power Meters for additional information.
LVDAM-EMS Software

Technical Information about the Programmable Meter Frequency Functions

The following functions are available for measuring frequency:

f(E1)
f(E2)
f(E3)
f(I1)
f(I2)
f(I3)

The above frequency functions determine frequency from the number of times the parameter indicated in parentheses goes through its mean value, either on a negative or positive slope, during a fixed time interval.

When the normal sampling window is used, frequency can be measured over a range of 45 Hz to 500 Hz when the AC network frequency is 60 Hz. When the AC network frequency is 50 Hz, the frequency range is 37.5 Hz to 500 Hz. When the extended sampling window is used, frequency can be measured over a range of 6 Hz to 1000 Hz for both the 50-Hz and 60-Hz AC network frequencies. The above frequency ranges are valid for voltage and current waveforms having a 50% duty cycle. The maximum frequency which can be measured may be reduced when the duty cycle is not 50%. Note that when the display of the programmable meter is of the analog type, the maximum frequency which can be measured also depends on the frequency range selected on this meter. See Sampling Window in Options Menu Commands to obtain additional information on the sampling window.

When auxiliary analog inputs are configured to measure frequency, they are added to the functions indicated above. When an auxiliary analog input is selected for measuring frequency, the mean value of the voltage at this input is measured and multiplied by a conversion factor, which depends on the configuration of the auxiliary analog input. See Auxiliary Analog Inputs to obtain information on the auxiliary analog inputs (AI-1 to AI-8).

Technical Information about the Programmable Meter Energy Functions

The following functions are available for measuring amounts of energy:

W1
W1+W2
W1+W2+W3

The energy functions W1, W1+W2, and W1+W2+W3 measure amounts of energy. Energy function W1 calculates the amount of energy using active power P1. Energy function W1+W2 calculates the amount of energy using the sum of active powers P1 and P2. Similarly, energy function W1+W2+W3 calculates the amount of energy using the sum of active powers P1, P2, and P3. Energy measurement
starts as soon as the meter is active. Energy is obtained by multiplying the active power by time. This is performed continually at short time intervals. The result obtained at each time interval is added to the sum of the results of the previous time intervals until the meter is reset to zero.

The method used to calculate active powers P1, P2, and P3 is the same as that used to calculate active power in the electrical power meters. See Technical Information about the Electrical Power Meters for additional information.

**Technical Information about the Programmable Meter Torque and Speed Functions**

The following functions are available for measuring torque and speed:

\[
T \\
N
\]

The torque function T measures the torque at input T. Operation is identical to that of torque meter T.

The speed function N measures the speed at input N. Operation is identical to that of speed meter N.

See Technical Information about the Torque and Speed Meters for additional information.

When auxiliary analog inputs are configured to measure torque, they are added to the torque function indicated above. Similarly, when auxiliary analog inputs are configured to measure speed, they are added to the speed function indicated above. When an auxiliary analog input is selected for measuring either torque or speed, the mean value of the voltage at this input is measured and multiplied by a conversion factor, which depends on the configuration of the auxiliary analog input. See Auxiliary Analog Inputs to obtain information on the auxiliary analog inputs (AI-1 to AI-8).

**Technical Information about the Programmable Meter Ratio Functions**

There is no pre-programmed function for measuring ratio.

When auxiliary analog inputs are configured to measure a ratio, they are displayed in the Input/Function list of the Meter Settings dialog box. When an auxiliary analog input is selected for measuring a ratio (expressed as a percentage), the mean value of the voltage at this input is measured and multiplied by a conversion factor, which depends on the configuration of the auxiliary analog input. See Auxiliary Analog Inputs to obtain information on the auxiliary analog inputs (AI-1 to AI-8).
Technical Information about the Programmable Meter Angle Functions

There is no pre-programmed function for measuring angle.

When auxiliary analog inputs are configured to measure angle, they are displayed in the Input/Function list of the Meter Settings dialog box. When an auxiliary analog input is selected for measuring angle, the mean value of the voltage at this input is measured and multiplied by a conversion factor, which depends on the configuration of the auxiliary analog input. See Auxiliary Analog Inputs to obtain information on the auxiliary analog inputs (AI-1 to AI-8).

Overrange Indication

Overrange occurs when the magnitude of the parameter being measured exceeds the capability of the selected meter range. For example, trying to measure a 50-V DC voltage using the 20-V range on a DC voltmeter results in overrange indication.

In the Metering window, the value indicated by a meter becomes red to indicate overrange.

Clipping Indication

Clipping occurs when the magnitude of the parameter being measured momentarily exceeds the measurement capability of a meter without the value of the parameter exceeds the capability of the range selected on that meter. In other words, clipping occurs when the parameter magnitude becomes such that the meter crest-factor rating is exceeded. For example, measuring a 150-V DC voltage with peaks of 500 V using the 200-V range on a DC voltmeter with a measurement capability of 400 V results in clipping indication.

In the Metering window, the value indicated by a meter becomes yellow to indicate clipping.

Data Table

The Data Table is used to record the values indicated by the various meters in the Metering application. The values recorded in this table can be edited, if desired, and are used to plot graphs using the Graph window.
You can refer to one of the following topics to obtain information on the menus, the toolbar or selecting data and editing data in the table.

Menus
Data Table Toolbar
Selecting Data
Editing Data

Menus (Data Table)

You can refer to one of the following topics to obtain information on the commands in one of the pull-down menus of the Data Table.

File Menu Commands
Edit Menu Commands
View Menu Commands
Options Menu Commands
Tools Menu Commands
Help Menu Commands

File Menu Commands (Data Table)

New

Starts a new data table. When the current contents of the Data Table have not been saved, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file.

Open...

Opens a Data Table file (filename.txt). The Open dialog box appears asking the name of the Data Table file you wish to open and the name of the directory where the file is located. Note that when the current contents of the Data Table have not been saved, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file.

Save, Save As...

The Save and Save As... commands save the current contents of the Data Table in a Data Table file (filename.txt).
LVDAM-EMS Software

Print...

Sends the Data Table window to the printer. Note that the menu bar and toolbar in the Data Table window are not sent to the printer.

The Print dialog box appears before the Data Table window is sent to the printer. This box allows the print setup and options to be modified before printing. The Data Table window is effectively sent to the printer after the OK button in the Print dialog box is clicked.

Close

Closes the Data Table window while keeping the Data Table contents in memory.

Edit Menu Commands (Data Table)

Record

Reads the values indicated by the meters in the Metering window and records these values in the Data Table at the row indicated by the row pointer. The row pointer is the number displayed next to the Record Data button in the Metering window. Note that the values indicated by the meters cannot be recorded if a row of data is already recorded in the Data Table and the settings of certain meters have changed since that data row has been recorded. This ensures that data recorded in each column of the Data Table are all of the same nature.

Insert Row

Inserts a row in the Data Table at the row that is currently selected. When a group of rows is selected in the Data Table, the row is inserted above the first row in the group. In both cases, the inserted row contains no data (zeros) and all following rows are pushed downwards in the Data Table.

Delete Row

Deletes the row or group of rows that are selected in the Data Table. All the following rows move upwards in the Data Table.

Clear Data Table

Clears all data in the Data Table. Note that a dialog box appears asking for confirmation before data is effectively cleared from the Data Table.
Copy Table to Clipboard

Copies the Data Table contents to the Clipboard. This provides an easy means for exporting data to a spreadsheet program like Microsoft® Excel.

Data Labels...

Opens the Data Labels dialog box. This box allows the data labels (column headers) in the Data Table to be edited. See Data Labels to obtain additional information on how to edit the data labels.

View Menu Commands (Data Table)

Menu Bar

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.

Toolbar

Determines whether or not the toolbar is displayed in the Data Table window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.

Options Menu Commands (Data Table)

Default Configuration

Restores the current configuration of the Data Table to the default configuration. The Data Table configuration defines the width of each column in the Data Table.

LVDAM-EMS Setup...

Opens the LVDAM-EMS Setup dialog box. This dialog box allows you to modify settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup to obtain additional information.
LVDAM-EMS Software

🎉 Tools Menu Commands (Data Table)

Each command in the Tools menu allows opening one of the following applications or the Graph window, or switching to one of these applications or the Graph window if it is already open.

You can refer to one of the following topics to obtain information on one of these applications or the Graph window:

- Metering
- Oscilloscope
- Phasor Analyzer
- Harmonic Analyzer
- Graph

Calculator is a Microsoft® Windows™ application that includes both a standard and scientific calculator. Refer to the Calculator Help to obtain information on how to use Calculator.

옜 Help Menu Commands (Data Table)

Contents

Enters the LVDAM-EMS help.

Search for Help on...

Opens a dialog box which allows help on a particular topic to be searched. Available topics are listed in alphabetical order.

蹾 Data Labels

The Data Labels dialog box allows the data labels used in the Data Table and Graph windows to be edited. To edit a data label, select the desired data label in the list, then edit the selected label using the keyboard.

Clicking the OK button applies the data labels defined in the Data Labels dialog box to the Data Table and Graph windows, and returns to either one of these windows.

Clicking the Cancel button returns to either the Data Table window or the Graph window without changing the data labels.
Clicking the Apply button applies the data labels defined in the Data Labels dialog box to the Data Table and Graph windows.

**Data Table Toolbar**

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Opening a Data Table File
- Saving a Data Table File
- Printing the Data Table
- Recording Data in Table
- Inserting a Row
- Deleting Rows
- Clearing the Data Table
- Opening the Graph window
- Opening the Metering application
- Opening the Oscilloscope application
- Opening the Phasor Analyzer application
- Opening the Harmonic Analyzer application
- Opening the LVDAM-EMS Setup dialog box

**Selecting Data**

A single data row can be selected by clicking the number located on the left side of the desired row. Note that the background color of the selected row is changed to indicate its selection. A group of successive data rows can also be selected. To do so, move the mouse pointer over the row number of the first row you wish to select, press the left mouse button, move the mouse pointer over the row numbers of the other rows you wish to select while holding down the mouse button, then release the button.

The selected data row or group of data rows can be released by clicking the empty box in the upper left corner of the data table or by selecting another data row.
LVDAM-EMS Software

Editing Data

The contents of the Data Table can be edited. To do so, select the data field to be edited by clicking it with the mouse, position the mouse pointer (a "I" beam in this case) at the place where you wish to start editing, click the left mouse button, then edit the data using the keyboard.

Once the data is edited, the selected field can be released by clicking the empty box in the upper left corner of the data table or by selecting another data field.

Graph

The Graph window allows curves representing the relationships between various parameters to be plotted simultaneously. The values of one or several of the various parameters recorded in the Data Table (E1, I3, P2, T, N etc.) are used to plot the graph.

You can refer to one of the following topics to obtain information on the menus, the toolbar or selecting the X- and Y-axis parameters of the graph.

- Menus
  - Graph Toolbar
  - X- and Y-Axis Parameter Selection

Menus (Graph)

You can refer to one of the following topics to obtain information on the commands in one of the menus of the Graph window.

- File Menu Commands
- Edit Menu Commands
- View Menu Commands
- Options Menu Commands
- Tools Menu Commands
- Help Menu Commands
- Context-Sensitive Menu Commands
File Menu Commands (Graph)

Print...

Sends the Graph window to the printer. Note that the menu bar and toolbar in the Graph window are not sent to the printer.

The Print dialog box appears before the Graph window is sent to the printer. This box allows the print setup and options to be modified before printing. The Graph window is effectively sent to the printer after the OK button in the Print dialog box is clicked.

Close

Closes the Graph window.

Edit Menu Commands (Graph)

Data Labels...

Opens the Data Labels dialog box. This box allows the data labels used in the Graph window to be edited. See Data Labels to obtain additional information on how to edit the data labels.

Titles...

Opens the Titles dialog box. This box allows you to enter or edit the graph title as well as the titles of the X and Y axes of the graph.

Clicking the OK button applies the titles entered in the Titles dialog box to the graph and returns to the Graph window.

Clicking the Cancel button returns to the Graph window without changing the titles.

View Menu Commands (Graph)

Line

Selects line segments to display relationships in the Graph window. A check mark appears beside the Line command in the View menu to indicate that line segments are selected. Note that the line segments can be used with discrete markers to display relationships in the Graph window.
LVDAM-EMS Software

Marker

Selects discrete markers (triangles, squares, lozenges) to display relationships in the Graph window. A check mark appears beside the Marker command in the View menu to indicate that discrete markers are selected. Note that the discrete markers can be used with line segments to display relationships in the Graph window.

Refresh

Refreshes the relationships displayed in the Graph window. Note that the Refresh button inscription becomes red when any of the parameter selections related to the X- and Y-axes are changed. This indicates that the graph should be refreshed because the displayed relationships no longer correspond to the selected parameters. See X- and Y-Axis Parameter Selection to obtain additional information on how to select the parameters related to the X and Y axes.

Menu Bar

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.

Toolbar

Determines whether or not the toolbar is displayed in the Graph window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.

Options Menu Commands (Graph)

Colors...

Opens the Colors dialog box. This box allows the color associated with each relationship (trace) displayed in the Graph window to be changed. See Colors to know how to change the color associated with each trace.

Default Configuration

Restores the current configuration of the Graph window to the default configuration. The Graph window configuration defines the position and size of the Graph window on the computer screen, the X- and Y-axis parameters, and the titles of the graph and axes.
In the default configuration of the Graph window, the sample numbers are selected as the X-axis parameter, no parameter is selected for the Y-axis, the file name of the Data Table that is currently open is used as the graph title, and the X and Y axes are left without titles.

LVDAM-EMS Setup...

Opens the LVDAM-EMS Setup dialog box. This dialog box allows you to modify settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup to obtain additional information.

Tools Menu Commands (Graph)

Each command in the Tools menu allows opening one of the following applications or the Data Table window, or switching to one of these applications or the Data Table window if it is already open.

You can refer to one of the following topics to obtain information on one of these applications or the Data Table window.

- Metering
- Oscilloscope
- Phasor Analyzer
- Harmonic Analyzer
- Data Table

Calculator is a Microsoft® Windows™ application that includes both a standard and scientific calculator. Refer to the Calculator Help to obtain information on how to use Calculator.

Help Menu Commands (Graph)

Contents

Enters the LVDAM-EMS help.

Search for Help on...

Opens a dialog box which allows help on a particular topic to be searched. Available topics are listed in alphabetical order.
Context-Sensitive Menu Commands (Graph)

A context-sensitive menu is available in the Graph window. The context-sensitive menu can be displayed by clicking the right mouse button when the mouse pointer is in the Graph window. The commands available in the context-sensitive menu are described below.

Data Labels...

See Data Labels... in Edit Menu Commands (Graph) for a description of this command.

Titles...

See Titles... in Edit Menu Commands (Graph) for a description of this command. Note that this command is not available when the context-sensitive menu is opened while the mouse pointer is on one of the Y-axis parameters that are available in the Graph window.

Colors...

See Colors... in Options Menu Commands (Graph) for a description of this command.

Colors (Graph)

The Colors dialog box allows the color associated with each relationship (trace) in the Graph window to be changed. To change the color associated with a trace, select a trace in the Trace list, then select the desired color by clicking the corresponding color in the color palette.

Clicking the Default button replaces the trace colors currently selected in the Colors dialog box with the default colors associated with the meters in the Metering window. The default meter colors are the original colors associated with the meters, in the default configuration of the Metering window.

Clicking the OK button applies the colors currently selected in the Colors dialog box to the traces in the Graph window and returns to the Graph window.

Clicking the Cancel button returns to the Graph window without changing the colors associated with the traces in the Graph window.

Clicking the Apply button applies the colors currently selected in the Colors dialog box to the traces in the Graph window.
Clicking the Help button provides help on the Colors dialog box.

**Graph Toolbar**

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Printing the Graph Window
- Selecting Line Segments for Graph Display
- Selecting Discrete Markers for Graph Display
- Refreshing the Graph
- Opening the Data Table window
- Opening the Metering application
- Opening the Oscilloscope application
- Opening the Phasor Analyzer application
- Opening the Harmonic Analyzer application
- Opening the LVDAM-EMS Setup dialog box

**X- and Y-Axis Parameter Selection**

**X-Axis Parameter Selection**

The X-axis parameter is selected by clicking the option button corresponding to the desired parameter. Note that the available parameters are the same as those in the currently-open Data Table. Also note that the row numbers of the Data Table (sample numbers) are selected as the default X-axis parameter.

**Y-Axis Parameter Selection**

A Y-axis parameter is selected by clicking the check box beside the desired parameter. A check mark appears in the box to confirm the selection. To cancel a selection, clear the parameter check box by clicking it again. Note that several Y-axis parameters can be selected simultaneously. Also note that the parameters which can be selected are those which are available in the currently-open Data Table.
PVDAE-EMS Software

Oscilloscope

The Oscilloscope in LVDAM-EMS allows time domain observation and analysis of electrical and mechanical parameters. Up to eight parameters can be observed at a time since the Oscilloscope has eight channels. The waveforms of the observed parameters are displayed on the Oscilloscope screen using different colors to facilitate observation.

You can refer to one of the following topics to obtain information on the menus, the toolbar, the status bar or using the Oscilloscope.

- Menus
  - Oscilloscope Toolbar
  - Oscilloscope Status Bar
  - Display Refresh
  - Time Base
  - Vertical Controls
  - Trigger Controls
  - X-Y Mode
  - Waveform Data
  - Memory
  - Technical Information about the Oscilloscope

Menus (Oscilloscope)

You can refer to one of the following topics to obtain information on the commands in one of the menus of the Oscilloscope application.

- File Menu Commands
- View Menu Commands
- Options Menu Commands
- Tools Menu Commands
- Help Menu Commands

File Menu Commands (Oscilloscope)

Open Workspace...

Opens a Workspace file (filename.dai). Opening a Workspace file allows you to recover an LVDAM-EMS environment that has been saved previously. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. When the
contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the current LVDAM-EMS environment in a Workspace file. See File Types to obtain a detailed description of the Workspace and Data Table files.

Save Workspace, Save Workspace As...

The Save Workspace and Save Workspace as... commands save the current LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Print...

Sends the Oscilloscope window to the printer. Note that the menu bar, toolbar, and status bar in the Oscilloscope window are not sent to the printer.

The Print dialog box appears before the Oscilloscope window is sent to the printer. This box allows the print setup and options to be modified before printing. The Oscilloscope window is effectively sent to the printer after the OK button in the Print dialog box is clicked.

Exit

Closes the Oscilloscope application. Note that the current configuration (instrument settings) of the Oscilloscope application is kept in memory when exiting while another LVDAM-EMS application is open.

When exiting the Oscilloscope application last at the end of a work session where the LVDAM-EMS environment has been changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Exit LVDAM-EMS

Closes all currently running applications of LVDAM-EMS. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer
screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace and Data Table files.

**View Menu Commands (Oscilloscope)**

**Trace**

Selects between the Normal, Square, and Dots modes of displaying the traces on the Oscilloscope screen. A check mark in the Trace command sub-menu indicates which mode is selected. In the Normal display mode, each trace is obtained by linking adjacent samples of the observed parameter with line segments. In the Square display mode, each trace is obtained by linking adjacent samples of the observed parameter with staircase steps. In the Dots display mode, each trace is obtained by displaying each sample of the observed parameter with a dot.

**Refresh**

Refreshes the waveforms displayed on the Oscilloscope screen and the contents of the Waveform Data table. Note that when this command is performed while automatic refresh of the waveforms and Waveform Data table contents (see Continuous Refresh in this topic for additional information) is selected, the current refreshing cycle is completed and the continuous refresh of the Oscilloscope is stopped. See Display Refresh for additional information.

**Continuous Refresh**

Determines whether the waveforms displayed on the Oscilloscope screen and the contents of the Waveform Data table are automatically refreshed at regular time intervals or refreshed manually using the Refresh button or the Refresh Command in the View menu. A check mark appears beside the Continuous Refresh command in the View menu when continuous refresh is selected. See Display Refresh for additional information.

**Always on Top**

Keeps the Oscilloscope application on top of other open applications. A check mark appears beside the Always on Top command in the View menu when this function is selected.

**Menu Bar**

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.
Toolbar

Determines whether or not the toolbar is displayed in the Oscilloscope window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.

Status Bar

Determines whether or not the status bar is displayed in the Oscilloscope window. A check mark appears beside the Status Bar command in the View menu when the status bar is displayed.

Options Menu Commands (Oscilloscope)

Colors...

Opens the Colors dialog box. This box allows the color associated with each channel of the Oscilloscope to be changed. It also allows the colors of the trace in the X-Y mode, cursors, display grid, display axes, and screen background to be changed. See Colors to know how to change the color associated with each of the various items in the Oscilloscope.

Cursor Unit (Horiz.)

Selects between the time (Seconds), phase angle (Degrees), and frequency (Hertz) units for indicating the horizontal positions of cursors 1 and 2 on the Oscilloscope screen and measuring the horizontal interval between these cursors. A check mark in the Cursor Unit command sub-menu indicates which unit is selected.

When the time unit is selected (Seconds option), the positions in time of cursors 1 and 2 and the time interval between these cursors are expressed in milliseconds (ms) or seconds (s) in the Waveform Data table.

When the phase angle unit is selected (Degrees option), the positions in time of cursors 1 and 2 and the time interval between these cursors are converted into phase angles based on the AC power network frequency, and expressed in degrees in the Waveform Data table.

When the frequency unit is selected (Hertz option), the time interval between cursors 1 and 2 is converted into the corresponding frequency and expressed in cycles per second (Hz) in the Waveform Data table. The positions in time of cursors 1 and 2 are not indicated.

See WaveFormData to obtain additional information on cursors 1 and 2.
LVDAM-EMS Software

X-Y Mode

Determines whether the Oscilloscope operates in the normal mode or X-Y mode. The operating mode is toggled each time this command is chosen. A check mark appears beside the X-Y Mode command in the Options menu when the X-Y Mode is selected. See X-Y Mode for additional information.

Auto Scale

Optimizes the scale settings of the various channels of the Oscilloscope according to the magnitude of the sampled parameters. Note that this function is not available when the sampled parameters need to be refreshed (when the time base is changed for example).

Default Configuration

Restores the current configuration (instrument settings) of the Oscilloscope application to the default configuration.

LVDAM-EMS

Opens the LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings dialog box. These dialog boxes allow you to modify the settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings to obtain additional information.

Tools Menu Commands (Oscilloscope)

Each command in the Tools menu allows opening one of the following applications or the Analog Outputs window, or switching to one of these applications or the Analog Outputs window if it is already open.

You can refer to one of the following topics to obtain information on one of the applications or the Analog Outputs window.

Metering
Phasor Analyzer
Harmonic Analyzer
Analog Outputs

Calculator is a Microsoft® Windows™ application that includes both a standard and scientific calculator. Refer to the Calculator Help to obtain information on how to use Calculator.
Visual Tour is a Lab-Volt Windows™ application that provides access to a library of Visual Tour presentations which summarize each laboratory exercise in the electrical power technology courseware.

Help Menu Commands (Oscilloscope)

Contents

Enters the LVDAM-EMS help.

Search for Help on...

Opens a dialog box which allows help on a particular topic to be searched. Available topics are listed in alphabetical order.

About Oscilloscope...

Opens a window which provides general information about the Oscilloscope application.

Oscilloscope Toolbar

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Opening a Workspace File
- Saving the LVDAM-EMS Environment in a Workspace File
- Printing the Oscilloscope Window
- Refreshing the Oscilloscope
- Continuously Refreshing the Oscilloscope
- Optimizing the Scale Settings of the Oscilloscope Channels
- Opening the Metering application
- Opening the Phasor Analyzer application
- Opening the Harmonic Analyzer application
LVDAM-EMS Software

- Opening the LVDAM-EMS Setup dialog box
- Opening the Visual Tour application

**Oscilloscope Status Bar**

The Oscilloscope status bar is located at the bottom of the Oscilloscope window.

The first field in the status bar is not used.

The second field indicates the mode in which LVDAM-EMS is operating. See *Operating Mode* for additional information.

The third field indicates the voltage and frequency of the AC power network. See Network in *Preferences* for additional information.

The fourth field indicates which mode of displaying the traces on the Oscilloscope screen is selected. See Trace in *View Menu Commands (Oscilloscope)* for additional information.

**Display Refresh (Oscilloscope)**

**Refresh**

The Oscilloscope display can be refreshed anytime by clicking the Refresh button. Note that when changing the time base setting or any of the observed parameters, the displayed waveforms and the contents of the Waveform Data table are erased (because they no longer correspond to the Oscilloscope settings) and the Refresh button inscription becomes red. This indicates that the observed parameters must be sampled to acquire new data which will be used to refresh the waveforms and the contents of the Waveform Data table. Also note that the displayed waveforms are automatically refreshed with the current data when any other Oscilloscope setting is changed.

**Continuous Refresh**

The Oscilloscope display is continuously refreshed at regular time intervals when the button located beside the Refresh button (Continuous Refresh button) is selected (depressed). To stop the continuous display refresh, click either the Refresh or the Continuous Refresh button, choose either the Refresh or Continuous Refresh command in the View menu or press the Escape (ESC) key of the keyboard.
LVDAM-EMS Software

Sampling Interruption

Oscilloscope display refresh (manual or continuous) sometimes results in a long sampling period when a slow time base setting is selected. In this case, the sampling of the parameters can be interrupted by pressing the Escape (ESC) key of the keyboard. Note that the fastest time base setting for which sampling interruption is possible depends on the number of parameters which are sampled. The fastest time base setting ranges from 200 ms/DIV when a single parameter is sampled to 2 s/DIV when thirteen parameters are sampled.

 대하여 Time Base

The Oscilloscope time base can be set by selecting the desired time base in the Time Base list or by using the Time Base scroll bar.

Note that the right and left buttons of the Time Base scroll bar respectively allow the time base to be increased and decreased in steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in the Time Base scroll bar allows the time base to be increased by a factor of ten. Similarly, clicking to the left of the cursor in the Time Base scroll bar allows the time base to be decreased by a factor of ten.

When the AC power network frequency is 60 Hz, a special time base of 1.67 ms/DIV allows a complete cycle of the line voltage or current waveform to coincide with the full width of the Oscilloscope screen.

Vertical Controls

Each of the eight channels of the Oscilloscope, which are numbered 1 to 8, has independent vertical controls. The vertical controls of each channel are used to set the scale (sensitivity) and select the observed parameter and the input coupling. Note that the vertical controls of channels 1 and 5 are in two folders which are superimposed. Clicking the tab of either one of the two folders displays the vertical controls of the corresponding channel. The same applies to the vertical controls of channels 2 and 6, 3 and 7, and 4 and 8.

Observed Parameter

The parameter to be observed is determined by selecting the desired parameter in the Input list. Note that selecting the None option in the Input list turns the channel off.
LVDAM-EMS Software

Scale

The scale can be set by selecting the desired scale in the Scale list or by using the Scale scroll bar. The right and left buttons of the Scale scroll bar allow the scale setting to be increased and decreased in steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in the Scale scroll bar allows the scale setting to be increased by a factor of ten. Similarly, clicking to the left of the cursor in the Scale scroll bar allows the scale setting to be decreased by a factor of ten.

The scale setting can be optimized according to the magnitude of the measured parameter by choosing the Auto Scale command in the Options menu or by clicking the Auto Scale button in the toolbar.

Input Coupling

The input coupling is selected by clicking one of the three option buttons. The three buttons, from left to right, correspond to DC coupling, AC coupling, and ground coupling.

Vertical Position of the Traces

The vertical position of the trace related to each channel can be adjusted by using the mouse to drag the corresponding ground symbol (it is of the color associated with the channel) on the left-hand side of the Oscilloscope screen. Note that when two or more traces are at the same vertical position, only one of the ground symbols related to these traces is shown. The ground symbol that is shown can be changed by clicking the tab of the vertical control folder of the channel corresponding to the desired trace.

Trigger Controls

The trigger controls are used to select the triggering parameter, determine whether triggering occurs on the positive or negative slope of the triggering parameter, and set the level at which triggering should occur. Furthermore, the trigger point can be moved horizontally on the Oscilloscope screen.

Triggering Parameter

The parameter used to trigger the Oscilloscope is determined by selecting a trigger source in the Source list. The available sources are channels 1 to 8, and an external source. For example, if the channel-1 option (Ch1) is selected in the Source list and channel 1 is used to observe voltage E1, the Oscilloscope will be triggered by voltage E1.
When the external source is selected (Ext. option selected in the Source list), the parameter list located beside the Source list allows the external source triggering parameter to be selected. The parameters that can be measured through the various inputs of the interface module are available in this list as well as the electrical and mechanical powers. Selecting the None option in the parameter list located beside the Source list turns off the trigger section, and the Oscilloscope operates in free-run mode. When the Sync. option in this list is selected, the TTL signal injected at the SYNC. INPUT is used to trigger the Oscilloscope. Furthermore, the trigger level and slope controls are disabled because the Oscilloscope is triggered by the rising edge of the TTL signal. Note that the Sync. option is available only when interface module 9062 is selected. See Interface / Acquisition Card in Preferences for additional information on the selection of the interface module.

Trigger Slope

The trigger slope is selected by clicking either the positive (+) or negative (-) Slope button.

Trigger Level

When one of the eight channels is selected as the trigger source, a triangular pointer is present on the right-hand side of the Oscilloscope screen. It points towards the Oscilloscope screen and indicates the trigger level. This trigger-level indicator can be dragged up or down using the mouse to adjust the trigger level. The Level display in the Trigger section indicates the value of the trigger level set with the trigger-level indicator. Note that when the external source is selected as the trigger source, the trigger level cannot be adjusted using the trigger-level indicator (the indicator is not shown in this case).

The trigger level can also be adjusted by editing the contents of the Level display. In this case, the vertical position of the trigger-level indicator is automatically adjusted so that it corresponds to the trigger level entered in the Level display. Note that the trigger-level indicator becomes red and is located at either the top or bottom end of the Oscilloscope screen, when the trigger level entered in the Level display is outside the range of trigger level corresponding to the full-height of the Oscilloscope screen. This indicates that the vertical position of the trigger-level indicator does not correspond to the trigger level entered in the Level display. However, in this situation, the trigger level is effectively set to the value indicated in the Level display.

Trigger Point Horizontal Position

The horizontal position of the trigger point is indicated by a triangular pointer located at the bottom of the Oscilloscope screen. This trigger-point indicator can be dragged left or right using the mouse to change the trigger-point horizontal position. Note that when the Sync. option is selected in the parameter list located beside the Source list, the horizontal position of the trigger point cannot be adjusted using the trigger-point indicator (the indicator is not shown in this case).
LVDAM-EMS Software

X-Y Mode

The X-Y mode of operation can be selected using the X-Y Mode command in the Options menu or by clicking the X-Y Mode button in the Time Base section. Note that the X-Y mode of operation is not available when no parameter (None option in the Input list) is selected on either channel 1 (X) or channel 2 (Y).

In the X-Y mode of operation, the parameters observed through channels 1 (X) and 2 (Y) are used to obtain a two-dimensional (2-D) plot on the Oscilloscope screen. The 2-D plot displayed on the Oscilloscope screen is automatically updated when the scale or input coupling of channel 1 or channel 2, is changed. The ground symbols at the bottom and left-hand side of the Oscilloscope screen allow the position of the two-dimensional plot to be modified. The Oscilloscope automatically returns to the normal mode of operation when selecting the None option in the Input list of channel 1 or channel 2.

Waveform Data

The Waveform Data table provides data on the parameters observed using the eight channels of the Oscilloscope. Data associated with up to four parameters can be displayed simultaneously. The displayed data is selected by clicking the channel buttons (Ch1 to Ch8) in the Waveform Data table. Furthermore, the nature of the data displayed in the table depends on whether or not the cursors have been selected. The cursors can be selected by clicking the Cursors check box with the mouse.

When the Cursors check box is cleared, the Waveform Data table indicates the root-mean-square (RMS) value, the average value (AVG), and the frequency (f) of each of the observed parameters. Note that when the observed parameter is electrical power (P1, P2, P3), a torque (T), a speed (N) or mechanical power (Pm), no data is indicated in the RMS column. Similarly, when the observed parameter is a torque (T), a speed (N) or mechanical power (Pm), no data is indicated in the frequency column. Also note that a question mark is displayed in the frequency column of the table when the frequency of a parameter cannot be evaluated. This may occur when less than one cycle of the waveform of that parameter is displayed on the Oscilloscope screen.

When the Cursors check box is checked, two cursors appear on the Oscilloscope screen. Cursor 1 is a vertical line at the left-hand end of the Oscilloscope screen. Similarly, cursor 2 is a vertical line at the right-hand end of the Oscilloscope screen. Each cursor is independent and can be moved horizontally by dragging it using the mouse.

The Cursor 1 and Cursor 2 columns of the Waveforms Data table indicate the instantaneous values of the observed parameters at the points of intersection with cursors 1 and 2. The Diff. column indicates the difference between the values in the Cursor 1 and Cursor 2 columns (Cursor 2 column value minus Cursor 1 column...
value) for each of the observed parameters. The last row of the Waveform Data
table (Position) indicates the horizontal position of each cursor and the horizontal
interval between the two cursors. These can be expressed in units of time, phase
angle or frequency depending on the cursor unit that is selected in the Options
menu. Note that in the Acquisition mode of operation, the positions and the interval
indicated in the Position row of the Waveform Data table may not correspond
exactly to the positions of the cursors on the Oscilloscope screen. However, the
values indicated in the Position row of the Waveform Data table are always exact.
See Cursor Unit in Options Menu Commands for additional information on the
cursor units.

Memory

The Oscilloscope is provided with two memories. The waveforms on the
Oscilloscope screen and the Oscilloscope settings are stored in memory 1 or 2 by
clicking Store button 1 or 2. Waveforms stored in memory 1 or 2 can be recalled for
display on the Oscilloscope screen by clicking View button 1 or 2. Note that the
Oscilloscope settings are also recalled from memory when waveforms stored in
memory 1 or 2 are displayed on the Oscilloscope screen.

Clicking the * button displays the waveforms stored in the * memory. The
waveforms on the Oscilloscope screen and the Oscilloscope settings are
automatically stored in the * memory when the waveforms stored in memory 1 or
2 are recalled and displayed on the Oscilloscope screen or when the Oscilloscope
screen need to be refreshed (after the time base or one of the observed parameters
is changed). This provides a means of recovering the waveforms that were
displayed on the Oscilloscope screen before the observation of waveforms recalled
from memory 1 or 2.

Colors (Oscilloscope)

The Colors dialog box allows the color associated with each channel of the
Oscilloscope to be changed. It also allows the colors of the trace in the X-Y mode,
cursors, display grid, display axes, and screen background to be changed. To
change the color associated with one of the various items in the Oscilloscope,
select an item in the Item list, then select the desired color by clicking the
corresponding color in the color palette.

Clicking the Default button replaces the colors currently selected in the Colors
dialog box with the default colors associated with the various items of the
Oscilloscope. The default colors are the original colors associated with the various
items, in the default configuration of the Oscilloscope application.

Clicking the OK button applies the colors currently selected in the Colors dialog box
to the various items in the Oscilloscope and returns to the Oscilloscope window.
Clicking the Cancel button returns to the Oscilloscope window without changing the colors associated with the various items in the Oscilloscope.

Clicking the Apply button applies the colors currently selected in the Colors dialog box to the various items in the Oscilloscope.

Clicking the Help button provides help on the Colors dialog box.

**Technical Information about the Oscilloscope**

You can refer to one of the following topics to obtain technical information on the Oscilloscope.

- Technical Information about Parameter Sampling
- Technical Information about Time Base Accuracy
- Technical Information about Trigger Operation
- Technical Information about Waveform Data Calculation

**Technical Information about Parameter Sampling (Oscilloscope)**

The Oscilloscope allows time domain observation and analysis of electrical and mechanical parameters. Up to eight parameters can be observed simultaneously since the Oscilloscope has eight channels. The parameters on all inputs of the interface module, except the SYNC. INPUT on interface module 9062, can be observed. Note that electrical powers P1, P2, P3 and the mechanical power Pm are derived from two input parameters. Power P1 is obtained using voltage E1 and current I1. Similarly, powers P2 and P3 are obtained using voltage E2 and current I2, and voltage E3 and current I3, respectively. Mechanical power Pm is obtained using the torque T and the speed N.

The parameters to be displayed on the Oscilloscope screen are sampled at the same time. To do so, the Oscilloscope takes a sample of each of the input parameters required to display the parameters selected in the eight channels. It repeats this cycle until a sufficient number of samples of each parameter is taken. This is similar to the chopped vertical mode on conventional oscilloscopes.

**Technical Information about Time Base Accuracy**

The waveform of each parameter on the Oscilloscope screen consists of 301 samples. The frequency at which the parameters are sampled (sampling frequency) is increased as the time base setting is decreased, so that the time required to obtain 301 samples of each parameter is as close as possible to the time interval
corresponding to the complete Oscilloscope screen (10 divisions). Similarly, the sampling frequency is also increased as the number of parameters to be sampled increases.

With interface module 9061 and data acquisition card PCL-711B, the maximum sampling frequency is 25 kHz. With interface module 9062 and data acquisition card ACL-8112PG, the maximum sampling frequency is 90.9 kHz when a single parameter is sampled. The maximum sampling frequency is at least 66.7 kHz when more than one parameter is sampled. Note that the maximum sampling frequency of data acquisition card ACL-8112PG can be changed. See Maximum Sampling Frequency in Preferences to obtain additional information.

When the combination of the number of parameters to be sampled and time base setting results in a sampling frequency that exceeds the maximum sampling frequency, the sampling frequency is set to maximum and the number of samples in each waveform is decreased so as the duration of the sampled waveforms is as close as possible to the time interval corresponding to the complete Oscilloscope screen. The decrease in the number of samples can be observed when the Dots mode of displaying the traces on the Oscilloscope screen is used. See Trace in View Menu Commands to obtain additional information on the various modes of displaying the traces on the Oscilloscope screen.

The accuracy of the time base setting depends on the ability to set the sampling frequency to the exact value that is required according to the time base setting and number of parameters that are sampled. This mainly depends on the acquisition device that is used. With either one of the data acquisition cards mentioned above, the time base accuracy is approximately 1%. Note, however, that the positions in time indicated in the Position row of the Waveform Data table are exact. See Waveform Data to obtain additional information on the Waveform Data table.

![Technical Information about Trigger Operation](image)

Technical Information about Trigger Operation

In the Oscilloscope, parameter sampling is started immediately after a display refresh command. The parameters are sampled during a period equal to twice the interval covered by the complete Oscilloscope screen. For instance, when the time base is set to 10 ms/DIV, the complete screen corresponds to a 100-ms interval, and thereby, the parameters are sampled during 200 ms.

Once sampling is finished, the triggering parameter is examined to find the instant at which it went through the trigger point. This instant is used to determine which portion of the sampled parameters is displayed on the Oscilloscope screen. When the triggering parameter does not go through the trigger point during the sampling period, the first half of the sampled parameters is displayed. Furthermore, when the triggering parameter goes through the trigger point during the second half of the sampling period, the number of samples taken after the trigger point may not be sufficient to display complete traces of the parameters on the screen. In this case, the first half of the sampled parameters is displayed.
Technical Information about Waveform Data Calculation

The rms and average values indicated in the Waveform Data table are calculated by the same methods as those used in the voltmeters, ammeters, power meters, the torque meter, and the speed meter of the Metering application. See Technical Information about the Voltmeters and Ammeters for additional information about the calculation of the rms and average values.

The frequency is determined from the number of times the measured parameter goes through its mean value, either on a negative or positive slope, during a fixed time interval. When the measured parameter never passes through the mean value, or passes through the mean value only one time during the measuring interval, a question mark is displayed in the Waveform Data table to indicate that frequency cannot be determined. In most cases, selecting AC coupling to remove the DC component from the measured parameter, or increasing the time base setting, will allow the frequency to be measured. Note that the threshold for detecting the number of times the measured parameter passes though the mean value is set to half the amplitude of the AC component of that parameter. This provides a certain immunity to noise on the waveform of the measured parameter.

Phasor Analyzer

The Phasor Analyzer in LVDAM-EMS allows observation and analysis of phase relationships between voltages and currents in three-phase power systems. Up to six phasors can be observed simultaneously on the Phasor Analyzer display. This display, referred to as phasor display, is a circle graduated in phase angle. The phasors corresponding to the observed parameters are displayed in this circle using different colors to facilitate observation.

You can refer to one of the following topics to obtain information on the menus, the toolbar, the status bar or on using the Phasor Analyzer.

Menus
Phasor Analyzer Toolbar
Phasor Analyzer Status Bar
Display Refresh
Phasor Selection and Scale Setting
Reference Phasor Selection
Phasor Data
Technical Information about the Phasor Analyzer
LVDAM-EMS Software

Menus (Phasor Analyzer)

You can refer to one of the following topics to obtain information on the commands in one of the menus of the Phasor Analyzer application.

File Menu Commands
View Menu Commands
Options Menu Commands
Tools Menu Commands
Help Menu Commands

File Menu Commands (Phasor Analyzer)

Open Workspace...

Opens a Workspace file (filename.dai). Opening a Workspace file allows you to recover an LVDAM-EMS environment that has been saved previously. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the current LVDAM-EMS environment in a Workspace file. See File Types to obtain a detailed description of the Workspace and Data Table files.

Save Workspace, Save Workspace As...

The Save Workspace and Save Workspace as... commands save the current LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Print...

Sends the Phasor Analyzer window to the printer. Note that the menu bar, toolbar, and status bar in the Phasor Analyzer window are not sent to the printer.

The Print dialog box appears before the Phasor Analyzer window is sent to the printer. This box allows the print setup and options to be modified before printing. The Phasor Analyzer window is effectively sent to the printer after the OK button in the Print dialog box is clicked.
LVDAM-EMS Software

Exit

Closes the Phasor Analyzer application. Note that the current configuration (instrument settings) of the Phasor Analyzer application is kept in memory when exiting while another LVDAM-EMS application is open.

When exiting the Phasor Analyzer application last at the end of a work session where the LVDAM-EMS environment has been changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Exit LVDAM-EMS

Closes all currently running applications of LVDAM-EMS. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace and Data Table files.

View Menu Commands (Phasor Analyzer)

Refresh

Refreshes the phasors on the Phasor Analyzer display and the contents of the Phasor Data table. Note that when this command is performed while automatic refresh of the phasors and Phasor Data table contents (see Continuous Refresh in this topic for additional information) is selected, the current refreshing cycle is completed and the continuous refresh of the Phasor Analyzer is stopped. See Display Refresh for additional information.

Continuous Refresh

Determines whether the phasors on the Phasor Analyzer display and the contents of the Phasor Data table are automatically refreshed at regular time intervals or refreshed manually using the Refresh button or the Refresh Command in the View menu. A check mark appears beside the Continuous Refresh command in the View menu when continuous refresh is selected. See Display Refresh for additional information.
Always on Top

Keeps the Phasor Analyzer application on top of other open applications. A check mark appears beside the Always on Top command in the View menu when this function is selected.

Menu Bar

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.

Toolbar

Determines whether or not the toolbar is displayed in the Phasor Analyzer window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.

Status Bar

Determines whether or not the status bar is displayed in the Phasor Analyzer window. A check mark appears beside the Status Bar command in the View menu when the status bar is displayed.

Options Menu Commands (Phasor Analyzer)

Colors...

Opens the Colors dialog box. This box allows the color associated with each phasor in the Phasor Analyzer window to be changed. See Colors to know how to change the color associated with each phasor.

Default Configuration

Restores the current configuration (instrument settings) of the Phasor Analyzer application to the default configuration.

LVDAM-EMS

Opens the LVDAM-EMS Setup or Analog Output Settings dialog box. These dialog boxes allow you to modify settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup or Analog Output Settings to obtain additional information.
LVDAM-EMS Software

**Tools Menu Commands (Phasor Analyzer)**

Each command in the Tools menu allows opening one of the following applications or the Analog Outputs window, or switching to one of these applications or the Analog Outputs window if it is already open.

You can refer to one of the following topics to obtain information on one of the applications or the Analog Outputs window.

- Metering
- Oscilloscope
- Harmonic Analyzer
- Analog Outputs

Calculator is a Microsoft® Windows™ application that includes both a standard and scientific calculator. Refer to the Calculator Help to obtain information on how to use Calculator.

Visual Tour is a Lab-Volt Windows™ application that provides access to a library of Visual Tour presentations which summarize each laboratory exercise in the electrical power technology courseware.

**Help Menu Commands (Phasor Analyzer)**

**Contents**

Enters the LVDAM-EMS help.

**Search for Help on...**

Opens a dialog box which allows help on a particular topic to be searched. Available topics are listed in alphabetical order.

**About Phasor Analyzer...**

Opens a window which provides general information about the Phasor Analyzer application.
Phasor Analyzer Toolbar

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Opening a Workspace File
- Saving the LVDAM-EMS Environment in a Workspace File
- Printing the Phasor Analyzer Window

- Refreshing the Phasor Analyzer
- Continuously Refreshing the Phasor Analyzer

- Opening the Metering application
- Opening the Oscilloscope application
- Opening the Harmonic Analyzer application

- Opening the LVDAM-EMS Setup dialog box
- Opening the Visual Tour application

Phasor Analyzer Status Bar

The Phasor Analyzer status bar is located at the bottom of the Phasor Analyzer window.

The first field in the status bar is not used.

The second field indicates the mode in which LVDAM-EMS is operating. See Operating Mode for additional information.

The third field indicates the voltage and frequency of the AC power network. See Network in Preferences for additional information.

Display Refresh (Phasor Analyzer)

Refresh

The Phasor Analyzer display can be refreshed anytime by clicking the Refresh button. Note that when changing any of the observed parameters or the reference
LVDAM-EMS Software

phasor, the displayed phasors and the contents of the Phasor Data table are erased (because they no longer correspond to the Phasor Analyzer settings) and the Refresh button inscription becomes red. This indicates that the parameters must be sampled to acquire new data which will be used to refresh the phasors and the contents of the Phasor Data table. Also note that the displayed phasors are automatically refreshed with the current data when the voltage or current scale setting is changed.

Continuous Refresh

The Phasor Analyzer display is continuously refreshed at regular time intervals when the button located beside the Refresh button (Continuous Refresh button) is selected (depressed). To stop the continuous display refresh, click either the Refresh or the Continuous Refresh button, choose either the Refresh or Continuous Refresh command in the View menu or press the Escape (ESC) key of the keyboard.

Phasor Selection and Scale Setting

The phasors displayed in the Phasor Analyzer window depends on the voltages (E1, E2, E3) and currents (I1, I2, I3) which are selected. A voltage or current is selected by clicking the corresponding check box in the Phasor Analyzer window. A check mark in a dialog box indicates that the corresponding parameter is selected.

The voltage and current scales used to display the phasors corresponding to the selected voltages and currents can be changed. The scale (sensitivity) used to display voltage phasors can be set by selecting the desired scale in the Voltage list or by using the Voltage scroll bar. Similarly, the scale (sensitivity) used to display current phasors can be set by selecting the desired scale in the Current list or by using the Current scroll bar.

Note that the right and left buttons of the Voltage or Current scroll bar allow the scale to be increased and decreased in steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in Voltage or Current scroll bar allows the scale to be increased by a factor of ten. Conversely, clicking to the left of the cursor in the Voltage or Current scroll bar allows the scale to be decreased by a factor of ten.

Reference Phasor Selection

A reference phasor is selected by choosing one of the parameters in the Reference Phasor list. The phasor corresponding to the selected parameter is displayed at a phase angle of 0 degrees, and is used as the reference to display the phasors.
corresponding to other parameters. Note that the phasor corresponding to voltage E1 is selected as the default reference phasor.

Phasor Data

The Phasor Data table provides data on the observed phasors. The AC-RMS column indicates the root-mean-square (rms) value of the AC component of the parameter related to each of the observed phasors. The Phase column indicates the phase angle with respect to the reference phasor for each of the observed phasors. The Frequency column indicates the frequency of the parameter related to each of the observed phasors. Note that a question mark is displayed in the frequency column when the frequency of a parameter cannot be measured.

See Technical Information about the Phasor Analyzer for additional information on the measurement of the AC-component rms value, phase angle, and frequency of the parameter related to each phasor.

Colors (Phasor Analyzer)

The Colors dialog box allows the color associated with each phasor in the Phasor Analyzer window to be changed. To change the color associated with a phasor, select a phasor in the Phasor list, then select the desired color by clicking the corresponding color in the color palette.

Clicking the Default button replaces the colors currently selected in the Colors dialog box with the default colors associated with the phasors in the Phasor Analyzer window. The default colors are the original colors associated with the phasors, in the default configuration of the Phasor Analyzer application.

Clicking the OK button applies the colors currently selected in the Colors dialog box to the phasors in the Phasor Analyzer window and returns to the Phasor Analyzer window.

Clicking the Cancel button returns to the Phasor Analyzer window without changing the colors associated with the phasors in the Phasor Analyzer window.

Clicking the Apply button applies the colors currently selected in the Colors dialog box to the phasors in the Phasor Analyzer window.

Clicking the Help button provides help on the Colors dialog box.
LVDAM-EMS Software

Technical Information about the Phasor Analyzer

The various scale settings in the Phasor Analyzer are graduated in rms voltage and current values per circular division.

The rms value of the AC component of each parameter is used to determine the length on the Phasor Analyzer display of the corresponding phasor. The rms value of the AC component is obtained by squaring each sample of the parameter, summing the squared values, and dividing the result by the number of samples. The parameter average value is squared, and then subtracted from the result of the first calculation. Finally, the square root of the subtraction is carried out to obtain the rms value of the AC component. Note that the parameter average value is obtained with the same method as that used in the voltmeters and ammeters of the Metering application. See Technical Information about the Voltmeters and Ammeters for additional information about the calculation of the average value.

To determine the angular position on the Phasor Analyzer display of the phasor related to a parameter, the phase angle between this parameter and the reference parameter (parameter whose phasor is selected as the reference phasor) must be determined. To do so, the frequency of the reference parameter is measured and used to determine the duration of one cycle (period) of the reference parameter waveform. The waveform of the parameter and that of the reference parameter are then compared to determine the time interval between the positive-slope zero crossings of these two parameters. This time is divided by the time corresponding to one period of the reference parameter waveform. The result is multiplied by 360 to obtain a phase angle expressed in degrees. Note that, before determining the phase angle, the average value of a parameter is subtracted from each sample of this parameter to eliminate the DC component.

The frequency of each parameter is determined from the number of times the parameter goes through its mean value, either on a negative or positive slope, during a fixed time interval. The frequency can be measured over a range of 45 Hz to 500 Hz when the AC network frequency is 60 Hz. When the AC network frequency is 50 Hz, the frequency range is 37.5 Hz to 500 Hz. The above frequency ranges are valid for voltage and current waveforms having a 50% duty cycle. The maximum frequency which can be measured may be reduced when the duty cycle is not 50%.

Harmonic Analyzer

The Harmonic Analyzer in LVDAM-EMS allows observation and analysis of the harmonic components or frequency spectrum of electrical parameters. One of the following input parameters can be selected for observation and analysis: voltages E1, E2, and E3, currents I1, I2, and I3, and the parameters at auxiliary analog inputs AI-1 to AI-8 that are configured to measure voltage or current. The harmonic components or frequency spectrum of the selected input parameter can be displayed on the Harmonic Analyzer display using various scale and range settings.
You can refer to one of the following topics to obtain information on the menus, the toolbar, the status bar or on using the Harmonic Analyzer.

**Menus**
- Harmonic Analyzer Toolbar
- Harmonic Analyzer Status Bar
- Display Refresh
- Harmonic Analyzer Settings
- Spectrum Analyzer Settings
- Harmonic Analyzer Cursors
- Spectrum Analyzer Cursors
- Harmonic Distortion Display
- Technical Information about the Harmonic Analyzer

**Menus (Harmonic Analyzer)**

You can refer to one of the following topics to obtain information on the commands in one of the menus of the Harmonic Analyzer application.

- File Menu Commands
- View Menu Commands
- Options Menu Commands
- Tools Menu Commands
- Help Menu Commands

**File Menu Commands (Harmonic Analyzer)**

**Open Workspace...**

Opens a Workspace file (filename.dai). Opening a Workspace file allows you to recover an LVDAM-EMS environment that has been saved previously. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the current LVDAM-EMS environment in a Workspace file. See *File Types* to obtain a detailed description of the Workspace and Data Table files.

**Save Workspace, Save Workspace As...**

The Save Workspace and Save Workspace as... commands save the current LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each...
LVDAM-EMS Software

LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Print...

Sends the Harmonic Analyzer window to the printer. Note that the menu bar, toolbar, and status bar in the Harmonic Analyzer window are not sent to the printer.

The Print dialog box appears before the Harmonic Analyzer window is sent to the printer. This box allows the print setup and options to be modified before printing. The Harmonic Analyzer window is effectively sent to the printer after the OK button in the Print dialog box is clicked.

Exit

Closes the Harmonic Analyzer application. Note that the current configuration (instrument settings) of the Harmonic Analyzer application is kept in memory when exiting while another LVDAM-EMS application is open.

When exiting the Harmonic Analyzer application last at the end of a work session where the LVDAM-EMS environment has been changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace files.

Exit LVDAM-EMS

Closes all currently running applications of LVDAM-EMS. When the contents of the Data Table have been changed, a dialog box appears asking if you wish to save the Data Table contents in a Data Table file. Similarly, when the LVDAM-EMS environment has changed, a dialog box appears asking if you wish to save the LVDAM-EMS environment in a Workspace file. The LVDAM-EMS environment includes the status (open or closed) and configuration (instrument settings) of each LVDAM-EMS application. It also includes the position and size on the computer screen of each LVDAM-EMS application. See File Types to obtain a detailed description of the Workspace and Data Table files.

View Menu Commands (Harmonic Analyzer)

Refresh

Refreshes the harmonic components or frequency spectrum shown in the Harmonic Analyzer display and other data in the Harmonic Analyzer window. Note that when
this command is performed while automatic refresh of the Harmonic Analyzer is selected (see Continuous Refresh in this topic for additional information), the current refreshing cycle is completed and the continuous refresh of the Harmonic Analyzer is stopped. See Display Refresh for additional information.

**Continuous Refresh**

Determines whether the display and data in the Harmonic Analyzer window are automatically refreshed at regular time intervals or refreshed manually using the Refresh button or the Refresh Command in the View menu. A check mark appears beside the Continuous Refresh command in the View menu when continuous refresh is selected. See Display Refresh for additional information.

**Always on Top**

Keeps the Harmonic Analyzer application on top of other open applications. A check mark appears beside the Always on Top command in the View menu when this function is selected.

**Menu Bar**

Removes the menu bar. The menu bar can be recovered by pressing the Escape (Esc) key on the keyboard. A check mark appears beside the Menu Bar command in the View menu when the menu bar is displayed.

**Toolbar**

Determines whether or not the toolbar is displayed in the Harmonic Analyzer window. A check mark appears beside the Toolbar command in the View menu when the toolbar is displayed.

**Status Bar**

Determines whether or not the status bar is displayed in the Harmonic Analyzer window. A check mark appears beside the Status Bar command in the View menu when the status bar is displayed.

![Options Menu Commands (Harmonic Analyzer)]

**Colors...**

Opens the Colors dialog box. This box allows the color associated with the selected input parameter (this color is used to display the harmonic components or frequency spectrum in the Harmonic Analyzer window) to be changed. It also allows the colors
LVDAM-EMS Software

of the cursors, graduations, and grid in the Harmonic Analyzer display to be changed. See Colors to know how to change the color associated with the various items in the Harmonic Analyzer.

Harmonic Analyzer Mode

Selects the Harmonic Analyzer mode of operation of the Harmonic Analyzer. When this mode is selected, the nature of the Harmonic Analyzer settings is changed, and the frequency spectrum and data displayed in the Harmonic Analyzer window (if any) are erased. A refresh command must be performed to display the different harmonic components in the selected input parameter as well as data on these harmonic components. A check mark appears beside the Harmonic Analyzer Mode command in the Options menu when the Harmonic Analyzer mode of operation is selected.

Spectrum Analyzer Mode

Selects the Spectrum Analyzer mode of operation of the Harmonic Analyzer. When this mode is selected, the nature of the Harmonic Analyzer settings is changed, and the harmonic components and data displayed in the Harmonic Analyzer window (if any) are erased. A refresh command must be performed to display the frequency spectrum of the selected input parameter as well as data related to this frequency spectrum. A check mark appears beside the Spectrum Analyzer Mode command in the Options menu when the Spectrum Analyzer mode of operation is selected.

Auto Scale

Optimizes the vertical (level) scale setting of the Harmonic Analyzer according to the magnitude of the selected input parameter. Note that this function is not available when the Harmonic Analyzer display needs to be refreshed (when the input parameter is changed for example). Also note that in the Harmonic Analyzer mode of operation, the Auto Scale function is not available when a relative scale (percentage scale) is selected for measuring the level of the harmonic components. See Vertical Scale Settings in Harmonic Analyzer Settings for additional information.

Default Configuration

Restores the current configuration (instrument settings) of the Harmonic Analyzer application to the default configuration.

LVDAM-EMS

Opens the LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings dialog box. These dialog boxes allow you to modify the settings that are common to all LVDAM-EMS applications. See LVDAM-EMS Setup, Analog Output Settings or Auxiliary Analog Input Settings to obtain additional information.
Tools Menu Commands (Harmonic Analyzer)

Each command in the Tools menu allows opening one of the following applications
or the Analog Outputs window, or switching to one of these applications or the
Analog Outputs window if it is already open.

You can refer to one of the following topics to obtain information on one of the
applications or the Analog Outputs window.

- Metering
- Oscilloscope
- Phasor Analyzer
- Analog Outputs

Calculator is a Microsoft® Windows™ application that includes both a standard and
scientific calculator. Refer to the Calculator Help to obtain information on how to
use Calculator.

Visual Tour is a Lab-Volt Windows™ application that provides access to a library
of Visual Tour presentations which summarize each laboratory exercise in the
electrical power technology courseware.

Help Menu Commands (Harmonic Analyzer)

Contents

Enters the LVDAM-EMS help.

Search for Help on...

Opens a dialog box which allows help on a particular topic to be searched.
Available topics are listed in alphabetical order.

About Harmonic Analyzer...

Opens a window which provides general information about the Harmonic Analyzer
application.
LVDAM-EMS Software

Harmonic Analyzer Toolbar

The buttons in the toolbar can be clicked to perform many different functions. The function related to each button is briefly described below.

- Opening a Workspace File
- Saving the LVDAM-EMS Environment in a Workspace File
- Printing the Harmonic Analyzer Window
- Refreshing the Harmonic Analyzer
- Continuously Refreshing the Harmonic Analyzer
- Optimizing the Scale Setting of the Harmonic Analyzer
- Selecting the Harmonic Analyzer Mode of Operation
- Selecting the Spectrum Analyzer Mode of Operation
- Opening the Metering application
- Opening the Oscilloscope application
- Opening the Phasor Analyzer application
- Opening the LVDAM-EMS Setup dialog box
- Opening the Visual Tour application

Harmonic Analyzer Status Bar

The Harmonic Analyzer status bar is located at the bottom of the Harmonic Analyzer window.

The first field in the status bar indicates the mode in which the Harmonic Analyzer is operating. See Harmonic Analyzer Mode and Spectrum Analyzer Mode in *Options Menu Commands (Harmonic Analyzer)* for additional information.

The second field indicates the mode in which LVDAM-EMS is operating. See *Operating Mode* for additional information.

The third field indicates the voltage and frequency of the AC power network. See Network in *Preferences* for additional information.
Display Refresh (Harmonic Analyzer)

Refresh

The Harmonic Analyzer display can be refreshed anytime by clicking the Refresh button. Note that when changing the mode of operation, selecting a different input parameter, or changing the fundamental frequency setting in the Harmonic Analyzer mode of operation, the display and data are erased (because they no longer correspond to the Harmonic Analyzer settings) and the Refresh button inscription becomes red. This indicates that the selected input parameter must be sampled to acquire new data which will be used to refresh the display and data in the Harmonic Analyzer window. Also note that the display is automatically refreshed with the current data when any other Harmonic Analyzer setting is changed.

Continuous Refresh

The Harmonic Analyzer display is continuously refreshed at regular time intervals when the button located beside the Refresh button (Continuous Refresh button) is selected (depressed). To stop the continuous display refresh, click either the Refresh or the Continuous Refresh button, choose either the Refresh or Continuous Refresh command in the View menu or press the Escape (ESC) key of the keyboard.

Harmonic Analyzer Settings

Setting the Harmonic Analyzer to observe the harmonic components of a parameter consists in selecting the Harmonic Analyzer mode of operation, choosing the input parameter, adjusting the vertical scale of the display, and determining the fundamental frequency and number of harmonic components. These settings, except the operating mode selection, are described in detail in this topic. See Harmonic Analyzer Mode in Options Menu Commands (Harmonic Analyzer) for additional information on the operating mode selection.

Input Parameter

The input parameter to be analyzed is determined by selecting the desired parameter in the Input list. Note that selecting the NONE option in the Input list turns the Harmonic Analyzer off.

Vertical Scale Settings

The vertical scale of the Harmonic Analyzer display, in the Harmonic Analyzer mode of operation, can be graduated with absolute values or relative values. The type of vertical scale is determined by selecting the desired option in the Scale
LVDAM-EMS Software

Type list. When absolute values are selected (V or A option in the Scale Type list), the vertical scale is graduated with root-mean-square (rms) values of voltage or current depending on the nature of the selected input parameter. When relative values are selected (% of DC and % of If options in the Scale Type list), the vertical scale is graduated with either percentages of the level of the DC component in the selected input parameter or percentages of the level of the fundamental component (harmonic component at the fundamental frequency) in the selected input parameter.

The vertical scale setting of the Harmonic Analyzer display is set by selecting the desired setting in the Scale Setting list or by using the Scale Setting scroll bar. Note that the right and left buttons of the Scale Setting scroll bar allow the vertical scale setting to be increased and decreased in steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in the Scale Setting scroll bar allows the vertical scale setting to be increased by a factor of ten. Similarly, clicking to the left of the cursor in the Scale Setting scroll bar allows the vertical scale setting to be decreased by a factor of ten.

Fundamental Frequency

The fundamental frequency of the Harmonic Analyzer can be set to the AC power network frequency, set manually by the user, or set automatically to the frequency of the fundamental component (harmonic component at the fundamental frequency) of the selected input parameter. The way the fundamental frequency is set in the Harmonic Analyzer is determined by selecting the desired option in the Fundamental Frequency list. The Fundamental Frequency display indicates the value of the fundamental frequency. Note that when the fundamental frequency of the Harmonic Analyzer is set manually (User option selected in the Fundamental Frequency list), the frequency indicated in the Fundamental Frequency display can be edited.

Number of Harmonics

The number of harmonic components in the Harmonic Analyzer display is set by selecting the desired number of harmonics in the Number of Harmonics list or by using the Number of Harmonics scroll bar. A maximum of forty harmonic components of the selected input parameter can be displayed. Note that the right and left buttons of the Number of Harmonics scroll bar allow the number of harmonic components to be increased and decreased by five. Furthermore, clicking to the right of the cursor in the Number of Harmonics scroll bar allows the number of harmonic components to be increased by ten. Similarly, clicking to the left of the cursor in the Number of Harmonics scroll bar allows the number of harmonic components to be decreased by ten.

Levels

The Levels section provides the levels of the DC component and the first forty harmonic components of the selected input parameter. These components are separated in three groups. The levels of the components in one of the three groups
are indicated in the Levels section. The group of components whose levels are indicated is determined by selecting the desired group in the Levels list. The first group (0 - 13 f option in the Levels list) contains the DC component plus the first thirteen harmonic components. The second group (14 - 27 f option in the Levels list) contains the harmonic components between the fourteenth and twenty-seventh harmonic components, inclusively. The third group (28 - 40 f option in the Levels list) contains the harmonic components between the twenty-eighth and fourtieth harmonic components, inclusively.

The component levels indicated in the Levels section are expressed as either absolute values or relative values. This depends on the type of vertical scale which is selected. See Vertical Scale Settings in this topic for additional information.

### Spectrum Analyzer Settings

Setting the Harmonic Analyzer to observe the frequency spectrum of a parameter consists in selecting the Spectrum Analyzer mode of operation, input parameter, vertical scale setting, and frequency span. These settings, except the operating mode selection, are described in detail in this topic. See Spectrum Analyzer Mode in Options Menu Commands (Harmonic Analyzer) for additional information on the operating mode selection.

#### Input Parameter

The input parameter to be analyzed is determined by selecting the desired parameter in the Input list. Note that selecting the NONE option in the Input list turns the Harmonic Analyzer off.

#### Vertical Scale Setting

The vertical scale of the Harmonic Analyzer display, in the Spectrum Analyzer mode of operation, is graduated with absolute values (root-mean-square (rms) values of voltage or current depending on the nature of the selected input parameter). The vertical scale setting of the Harmonic Analyzer display is set by selecting the desired setting in the Scale Setting list or by using the Scale Setting scroll bar. Note that the right and left buttons of the Scale Setting scroll bar allow the vertical scale setting to be increased and decreased in steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in the Scale Setting scroll bar allows the vertical scale setting to be increased by a factor of ten. Similarly, clicking to the left of the cursor in the Scale Setting scroll bar allows the vertical scale to be decreased by a factor of ten.

#### Frequency Span

The frequency span of the Harmonic Analyzer display, in the Spectrum Analyzer mode of operation, is set by selecting the desired span in the Frequency Span list.
or by using the Frequency span scroll bar. Note that the right and left buttons of the Frequency Span scroll bar allow the frequency span to be increased and decreased by steps according to a 1-2-5 sequence. Furthermore, clicking to the right of the cursor in the Frequency Span scroll bar allows the frequency span to be increased by a factor of ten. Similarly, clicking to the left of the cursor in the Frequency Span scroll bar allows the frequency span to be decreased by a factor of ten.

Harmonic Analyzer Cursors

This topic describes the operation of the cursors when the Harmonic Analyzer mode of operation is selected. See Spectrum Analyzer Cursors for information on the operation of the cursors in the Spectrum Analyzer mode of operation.

Vertical or horizontal cursors can be displayed on the Harmonic Analyzer display by clicking either the V (vertical cursors) button or H (horizontal cursors) button in the Cursors section. No cursors are displayed when the O button is selected.

Vertical Cursors

The vertical cursors are two vertical lines on the Harmonic Analyzer display which can be moved to any of the harmonic component positions in the display. These cursors are labelled C1 and C2. Each cursor is independent and can be moved from one harmonic component position to another by dragging it with the mouse. Each cursor can also be moved one harmonic component position at a time using the corresponding up and down seek buttons.

The Harmonic, Frequency, and Level data fields in the Cursors section indicate the number, frequency, and level of the harmonic component on which each vertical cursor is positioned. Note that the levels indicated in the Level data fields are expressed as either absolute values or relative values. This depends on the type of vertical scale which is selected. See Vertical Scale Settings in Harmonic Analyzer Settings for additional information.

Horizontal Cursors

The horizontal cursors are two horizontal lines on the Harmonic Analyzer display which can be set to different levels. These cursors are labelled C1 and C2. Each cursor is independent and can be set to any level by dragging it with the mouse. The level of each cursor can also be set to the level of any of the harmonic components in the display using the corresponding up and down seek buttons. In this case, the cursor level is increased or decreased to the level of the harmonic component that is closest to the current level of the cursor, depending on whether the up or down seek button is used.

The Level data fields in the Cursors section indicate the level of each horizontal cursor. Note that these levels are expressed as either absolute values or relative
LVDAM-EMS Software

values. This depends on the type of vertical scale which is selected. See Vertical Scale Settings in Harmonic Analyzer Settings for additional information.

Spectrum Analyzer Cursors

This topic describes the operation of the cursors when the Spectrum Analyzer mode of operation is selected. See Harmonic Analyzer Cursors for information on the operation of the cursors in the Harmonic Analyzer mode of operation.

Vertical or horizontal cursors can be displayed on the Spectrum Analyzer display by clicking either the V (vertical cursors) button or H (horizontal cursors) button in the Cursors section. No cursors are displayed when the O button is selected.

Vertical Cursors

The vertical cursors are two vertical lines on the Spectrum Analyzer display which can be moved to different frequencies in the display. These cursors are labelled C1 and C2. Each cursor is independent and can be moved in frequency by dragging it with the mouse. Each cursor can also be moved in frequency by short steps using the corresponding up and down buttons. Each cursor can be positioned on the next frequency component in the display which exceeds the seek level, using the corresponding up and down seek buttons. The seek level is indicated by a triangular pointer located on the right-hand side of the display. This pointer can be dragged up or down using the mouse to adjust the seek level.

The Frequency and Level data fields in the Cursors section indicate the frequency and level of the frequency component (if any) aligned with each vertical cursor.

Horizontal Cursors

The horizontal cursors are two horizontal lines on the Harmonic Analyzer display which can be set to different levels. These cursors are labelled C1 and C2. Each cursor is independent and can be set to any level by dragging it with the mouse. The level of each cursor can be changed by short steps using the corresponding up and down buttons. The level of each cursor can also be set to the level of any of the frequency components in the display using the corresponding up and down seek buttons. In this case, the cursor level is increased or decreased to the level of the frequency component that is closest to the current level of the cursor, depending on whether the up or down seek button is used.

The Level data fields in the Cursors section indicate the level of each horizontal cursor.
LVDAM-EMS Software

Harmonic Distortion Display

The Distortion display of the Harmonic Analyzer indicates the total harmonic distortion (THD) of the selected input parameter, when the Harmonic Analyzer mode of operation is selected. See Technical Information about the Harmonic Analyzer to obtain additional information.

Colors (Harmonic Analyzer)

The Colors dialog box allows the color associated with the selected input parameter (this color is used to display the harmonic components or frequency spectrum in the Harmonic Analyzer window) to be changed. It also allows the colors of the cursors, graduations, and grid in the Harmonic Analyzer display to be changed. To change the color associated with one of the various items in the Harmonic Analyzer, select an item in the item list, then select the desired color by clicking the corresponding color in the color palette.

Clicking the Default button replaces the colors currently selected in the Colors dialog box with the default colors associated with the various items of the Harmonic Analyzer. The default colors are the original colors associated with the various items, in the default configuration of the Harmonic Analyzer application.

Clicking the OK button applies the colors currently selected in the Colors dialog box to the various items in the Harmonic Analyzer and returns to the Harmonic Analyzer window.

Clicking the Cancel button returns to the Harmonic Analyzer window without changing the colors associated with the various items in the Harmonic Analyzer.

Clicking the Apply button applies the colors currently selected in the Colors dialog box to the various items in the Harmonic Analyzer.

Clicking the Help button provides help on the Colors dialog box.

Technical Information about the Harmonic Analyzer

Data Sampling and Fast Fourier Transform (FFT)

In the Harmonic Analyzer, the selected input parameter is sampled during a certain time interval each time a refresh command is performed. A fast Fourier transform (FFT) is then performed using the sampled data to obtain the frequency components of the selected input parameter.
In the Harmonic Analyzer mode, the sampling of the selected input parameter is optimized so that the output components of the FFT are at frequencies which are as close as possible to multiples of the fundamental frequency. The FFT components are used directly to display the harmonic components of the selected input signal.

In the Spectrum Analyzer mode, the selected input parameter is sampled at a frequency of 10 kHz until 8192 samples have been taken. The output components of the FFT obtained with this data are located at 0 Hz (DC component), 1.22 Hz, and multiples of 1.22 Hz. The FFT components are used directly to display the frequency spectrum of the selected input signal.

**Frequency Range**

The frequency range of the Harmonic Analyzer is 0 Hz (DC component) and 1 Hz to 5 kHz.

**Fundamental-Frequency Range**

The fundamental-frequency range is 1 Hz to 200 Hz.

**RMS Value Calculation**

The rms values of the fundamental component and harmonic components are obtained by dividing the amplitude of the corresponding FFT output components by 1.4142 (square root of 2).

**Calculation of the Total Harmonic Distortion**

The total harmonic distortion is obtained by dividing the root-mean-square (rms) value of the harmonic components (excluding the fundamental component) by the rms value of the ac component of the selected input parameter.

The rms value of the harmonic components is obtained by squaring the value of each harmonic component, from the second harmonic to the fortieth harmonic inclusively, summing the squared values, and calculating the square root of the sum.

The rms value of the ac component of the selected input parameter is obtained by squaring the value of each of the first forty harmonic components, summing the squared values, and calculating the square root of the sum.
LVDAM-EMS Software

LVDAM-EMS Setup

The LVDAM-EMS Setup dialog box allows LVDAM-EMS to be set according to your needs. This dialog box allows changing the preferences (operating mode, language, measurement units, combination of interface module and data acquisition card, etc.) and the settings of the interface, setting the simulation parameters used in the simulation mode, and correcting the offsets that affect the inputs of the interface module.

You can refer to one of the following topics to obtain information on the contents of the different folders in the LVDAM-EMS Setup dialog box. Note that a folder is opened by clicking one of the tabs in the LVDAM-EMS Setup dialog box.

- Preferences
- Simulation Parameters
- Offsets
- Interface

Clicking the Default button sets all options in the LVDAM-EMS Setup dialog box to the default values.

Clicking the Save button saves the options currently set in the LVDAM-EMS Setup dialog box to the LVEA20.INI file. The next time LVDAM-EMS is started, these settings will be used as the default setup. The default setup set at factory can be recovered and saved anytime by first clicking the Default button and then clicking the Save button.

Clicking the OK button applies the options currently set in the LVDAM-EMS Setup dialog box to LVDAM-EMS and closes the LVDAM-EMS Setup dialog box.

Clicking the Cancel button closes the LVDAM-EMS Setup dialog box without changing the LVDAM-EMS setup. Note that any unsaved option setting in the LVDAM-EMS Setup dialog box is lost when clicking the Cancel button.

Clicking the Apply button applies the options currently set in the LVDAM-EMS Setup dialog box to LVDAM-EMS, without closing the LVDAM-EMS Setup dialog box.

Clicking the Help button provides help on the LVDAM-EMS Setup dialog box.

Preferences

The Preferences folder in the LVDAM-EMS Setup dialog box allows changing the software preferences as well as the hardware preferences. The available preferences are described in this topic.
Operating Mode

The Operating Mode list allows the operating mode of LVDAM-EMS to be selected. The following three operating modes are available: Acquisition, Simulation, and Virtuality. Note that the Virtuality mode can be selected only when the LVSim®-EMS application is running. See Operating Mode for additional information.

Language

LVDAM-EMS can operate in several languages. Available languages are English, French, and Spanish. The language is selected by clicking the desired language in the Language list. Note that the language can be changed while LVDAM-EMS is running.

Units

International (SI) units, imperial units or a combination of international and imperial units can be used in LVDAM-EMS. The units are selected by clicking the option corresponding to the desired units in the Units list.

Pop-Up Help

The option selected in the Pop-Up Help list determines whether or not pop-up help is active. When pop-up help is active, help appears in a small yellow box when the mouse pointer stays over a button, an object, etc.

File Path

The file path used when opening or saving a file in LVDAM-EMS can be changed using the Browse function. Note that when no path is indicated, the path leading to the folder where the LVDAM-EMS applications are installed is used.

Network (Voltage/Frequency)

Several AC power networks with different combinations of voltage and frequency are available in LVDAM-EMS. A network is selected by clicking the desired combination of voltage and frequency in the Network (Voltage/Frequency) list. Note that the network can be changed while LVDAM-EMS is running.

Interface / Acquisition Card

An interface module is required to interconnect the electromechanical system or power electronics circuit with the computer which runs LVDAM-EMS. Furthermore, a data acquisition card is also required to sample the parameters (voltages, currents, torques, speeds, etc.) sensed with the interface module. The data acquisition card is installed in the computer which runs LVDAM-EMS. The
LVDAM-EMS Software

Interface / Acquisition Card list allows selection of a combination of interface module and data acquisition card. A combination is selected regardless of the operating mode. This selection allows LVDAM-EMS to properly control the interface module and data acquisition card.

Acquisition Card Base Address

Allows selection of the base address of the data acquisition card. The default base address of data acquisition card PCL-711B, expressed as an hexadecimal number, is 220. The default base address of data acquisition card ACL-8112PG is 230. Note that this selection must correspond to the base address set on the data acquisition card. See the documentation provided by the manufacturer of the data acquisition card to know how to set the base address.

Maximum Sampling Frequency

When data acquisition card ACL-8112PG is selected, allows selection of the maximum frequency at which parameters can be sampled. When the Auto option is selected, the maximum sampling frequency is automatically set to 83.3 kHz when a single parameter is sampled. Otherwise (when more that one parameter is sampled), the maximum sampling frequency is automatically set to 66.7 kHz. Note that the maximum frequency at which parameters can be sampled is fixed (25 kHz) when data acquisition card PCL-711B is selected.

Operating Mode

LVDAM-EMS can operate in one of the following three modes: Acquisition, Simulation, and Virtuality.

In the Acquisition mode, LVDAM-EMS samples the parameters (voltages, currents, torques, speeds, etc.) using an interface module and a data acquisition card.

In the Simulation mode, LVDAM-EMS simulates voltages E1, E2, and E3, currents I1, I2, and I3, torque T, and speed N according to the characteristics contained in the Simulation Parameters folder.

In the Virtuality mode, LVDAM-EMS simulates voltages E1, E2, and E3, currents I1, I2, and I3, torque T, and speed N according to the characteristics contained in the Simulation Parameters folder, as in the Simulation mode. However, the characteristics contained in the Simulation Parameters folder are continuously updated by the LVSIM®-EMS application.
LVDAM-EMS Software

LVSIM®-EMS

LVSIM®-EMS is a Windows™ application that simulates the Lab-Volt ElectroMechanical System (EMS) equipment. This equipment includes motors, generators, transformers, a power supply, loads, etc. When LVSIM®-EMS is running, LVDAM-EMS can be used in the Virtuality mode to measure electrical and mechanical parameters in the simulated electromechanical system. See the LVSIM®-EMS help or contact Lab-Volt to obtain more information about LVSIM®-EMS.

Simulation Parameters

The Simulation Parameters folder in the LVDAM-EMS Setup dialog box is used to set the characteristics of the electrical and mechanical parameters when LVDAM-EMS operates in the Simulation or Virtuality mode. See Operating Mode to obtain additional information on the Simulation and Virtuality modes.

Voltages E1, E2, E3, currents I1, I2, I3, torque T, and speed N are the parameters which are simulated. For each voltage and current, the DC component and the root-mean-square (rms) value, frequency, and phase of the AC component can be set. The value of the torque and speed can also be set. To set a parameter characteristic, select the corresponding field by clicking it with the mouse, then edit the characteristic using the keyboard.

Clicking the Default button in the Simulation Parameters folder sets the simulated parameters to the default values set at the factory, taking into account the AC power network currently selected in the Preferences folder of the LVDAM-EMS Setup dialog box. See Network (Voltage/Frequency) in Preferences for additional information on the selection of the AC power network.

The Open... and Save... buttons allow simulation parameter files to be opened and saved, respectively.

Offsets

DC offset voltages in the interface module and data acquisition card introduce constant errors (offset errors) when measuring the parameters at the inputs of the interface module (E1, I2, T, N, etc.). LVDAM-EMS is provided with a function that corrects measurement errors due to these DC offset voltages. This function subtracts a value equal to the DC offset (offset correction value) from each sample of the parameter to correct the offset error.

The Offsets folder in the LVDAM-EMS Setup dialog box allows recording the offset correction value used with each input of the interface module. Note that the Offsets
LVDAM-EMS Software

folder can be accessed only when the Acquisition operating mode is selected. The following procedure indicates how to record the offset correction values.

1. Make sure the interface module and the data acquisition card are installed.

2. Make sure inputs E1, E2, E3, I1, I2, and I3 of the interface module are left open.

3. Make sure that the T and N inputs of the interface module are connected to the common point.

4. If interface module 9062 is used, make sure that all auxiliary analog inputs on this module are connected to the common point.

5. The meters in the Current Average Value columns of the Offsets folder indicate the average value (offset) of the parameter measured at each input of the interface module.

6. Click the Calibrate All button to record the offset correction values for all inputs of the interface module. The recorded offset correction values are indicated in the Offset Correction columns of the Offsets folder. To record an offset correction value for a single input, click the arrow button of the corresponding input.

Note that all offset correction values can be reset to zero by clicking the Reset button.

Also note that each offset correction value can be edited. To do so, place the mouse pointer over the field that contains the offset correction value to be edited. The mouse pointer takes the form of an I beam when it is located on a field containing an offset correction value. Position the I beam at the place where you wish to start editing, click the left button of the mouse, then edit the offset correction value using the keyboard.

Interface

The Interface folder in the LVDAM-EMS Setup dialog box allows selection of the measuring range of inputs E1, E2, E3, I1, I2, and I3 on the interface module. It also allows the control functions of the analog outputs to be defined and the settings of the auxiliary analog inputs to be modified.

Input Ranges

The range of inputs E1, E2, E3, I1, I2, and I3 on the interface module can be set to low or high, or it can be set automatically (auto range) by the computer running LVDAM-EMS according to the amplitude of the parameters to be measured. The range of each of these inputs is determined by selecting the High, Low or Auto option in the corresponding Input Range list.
Clicking the All Auto button let the computer set the range of inputs E1, E2, E3, I1, I2, and I3 according to the amplitude of the parameters to be measured.

Clicking the All Low button set the range of inputs E1, E2, E3, I1, I2, and I3 to low. Similarly, clicking the All High button set the range of these inputs to high.

**Analog Output Settings...**

The Analog Output Settings... button opens the Analog Output Settings dialog box. This dialog box allows the control functions of the analog outputs to be defined or modified. See **Analog Output Settings** to obtain additional information.

**Auxiliary Analog Input Settings...**

The Aux. Analog Input Settings... button opens the Auxiliary Analog Input Settings dialog box. This dialog box allows the settings of the auxiliary analog inputs to be modified. See **Auxiliary Analog Input Settings** to obtain additional information.

**Analog Output Settings**

The control function implemented using each of the analog outputs is defined by the type of parameter that is controlled, the minimum and maximum values of the controlled parameter and the corresponding voltages at the analog output, and the size of the steps used when varying the controlled parameter. These control functions are defined in the Analog Output Settings dialog box.

For each analog output, the type of parameter which is controlled (voltage, current, speed, frequency, angle, etc.) is selected by clicking the desired option in the Type list.

For each analog output, the minimum and maximum values of the controlled parameter are indicated in the Min. and Max. Displayed Value data fields, respectively. The voltages at the analog output which correspond to the minimum and maximum values of the controlled parameter are indicated in the Min. and Max. Corresponding Output Voltage data fields, respectively. The size of the steps used when varying the controlled parameter is indicated in the Step data field.

To edit any of the data, place the mouse pointer over the field that contains the data to be edited. The mouse pointer takes the form of an I beam when it is located on a data field. Position the I beam at the place where you wish to start editing, click the left button of the mouse, then edit the data using the keyboard.

Clicking the Default button replaces the analog output functions currently defined in the Analog Output Settings dialog box with default output functions.
LVDAM-EMS Software

Clicking the OK button applies the analog output functions currently defined in the Analog Output Settings dialog box to LVDAM-EMS and closes the Analog Output Settings dialog box.

Clicking the Cancel button closes the Analog Output Settings dialog box without changing the analog output functions. Note that the analog output functions currently defined in the Analog Output Settings dialog box, if not applied, are lost when clicking the Cancel button.

Clicking the Apply button applies the analog output functions currently defined in the Analog Output Settings dialog box to LVDAM-EMS, without closing the Analog Output Settings dialog box.

Clicking the Help button provides help on the Analog Output Settings dialog box.

Auxiliary Analog Input Settings

The settings (configuration) of each of the auxiliary analog inputs determine the type of parameter that is measured and the minimum and maximum values of that parameter which can be measured through the auxiliary analog input. The configuration of each auxiliary analog input can be modified through the Auxiliary Analog Input Settings dialog box.

For each auxiliary analog input, the type of parameter (voltage, speed, frequency, angle, etc.) that is measured is selected by clicking the desired option in the Type list. Once the type of parameter is selected, two data fields indicate the values of the measured parameter which corresponds to voltages of +10 V and -10 V at the auxiliary analog input. These values can be edited. To do so, place the mouse pointer over the data field to be edited. The mouse pointer takes the form of an I beam when it is located over a data field. Position the I beam at the place where you wish to start editing, click the left button of the mouse, then edit the value using the keyboard.

Clicking the Default button replaces the auxiliary analog input configurations currently defined in the Auxiliary Analog Input Settings dialog box with default input configurations.

Clicking the OK button applies the auxiliary analog input configurations currently defined in the Auxiliary Analog Input Settings dialog box to LVDAM-EMS and closes the Auxiliary Analog Input Settings dialog box.

Clicking the Cancel button closes the Auxiliary Analog Input Settings dialog box without changing the auxiliary analog input configurations. Note that the auxiliary analog input configurations currently defined in the Auxiliary Analog Input Settings dialog box, if not applied, are lost when clicking the Cancel button.

Clicking the Apply button applies the auxiliary analog input configurations currently defined in the Auxiliary Analog Input Settings dialog box to LVDAM-EMS, without closing the Auxiliary Analog Input Settings dialog box.
Clicking the Help button provides help on the Auxiliary Analog Input Settings dialog box.

**Auxiliary Analog Inputs**

Eight auxiliary analog inputs, referred to as Al-1 to Al-8, are available on interface module 9062 for measuring additional parameters. The voltage range of each of these inputs is +10 V to -10 V. Different types of measuring devices, such as voltage and current isolators, speed sensors, frequency sensors, etc. can be connected to these inputs to measure various types of parameters. Note that no auxiliary analog inputs are available on interface module 9061.

Each auxiliary analog input can be configured according to the type of parameter that is measured and the characteristics of the measuring device. The Auxiliary Analog Input Settings dialog box allows the configuration of the auxiliary analog inputs to be modified. See *Auxiliary Analog Input Settings* to obtain additional information on how to modify the configuration of the auxiliary analog inputs.

**Analog Outputs**

The analog outputs are real (hardware) outputs. Each output provides a voltage that can be used to control a parameter (voltage, current, speed, torque, etc.) through an external device. Note that only one analog output is available on interface module 9061.

**Varying the Voltages at the Analog Outputs**

The voltages at the analog outputs, and thereby, the values of the controlled parameters, are set through the Analog Outputs box. This box is displayed by choosing the Analog Outputs command in the Tools menu of any of the LVDAM-EMS applications.

In the Analog Outputs box, a control knob, increment and decrement buttons, and a display are provided for each analog output. The control knob allows continuous variation of the controlled parameter. The setting of the control knob is modified by dragging the red dot on the knob using the mouse. The increment and decrement buttons allow the controlled parameter to be varied by steps. The display indicates the current value of the controlled parameter. Note that clicking the right mouse button while the mouse pointer is over one of the control knobs opens a context-sensitive menu. The commands in this menu allow the corresponding control knob to be set to the minimum or maximum position.

**Functions of the Analog Outputs**

The control functions implemented using the analog outputs are defined in the Analog Output Settings dialog box. This dialog box can be opened by clicking the Analog Output Settings... button in the Analog Outputs box. See *Analog Output Settings* to obtain additional information on how to define the control functions.
LVDAM-EMS Software

File Types

Files of several different types are used in LVDAM-EMS. The different file types are described below.

Workspace file (filename.dai)

File that contains an LVDAM-EMS environment. This includes the configuration (instrument settings) of each LVDAM-EMS application, the position and size on the computer screen of each LVDAM-EMS application, and the settings of the Auxiliary Analog Inputs and Analog Outputs. However, this excludes the preferences, simulation parameters, offsets, and input ranges selected in the LVDAM-EMS Setup window. These are saved in the LVDAM-EMS configuration setting file (LVEA20.INI).

Data Table file (filename.txt)

ASCII type file that contains the measured values of parameters that were recorded in the Data Table while using the Metering application. Note that the data labels (column headers) are also saved in the Data Table file.

Simulation Parameters file (filename.sim)

File that contains the characteristics of the simulated parameters used when LVDAM-EMS operates in the Simulation Mode. To open and save a Simulation Parameters file, use the Open... and Save... button in the Simulation Parameters folder of the LVDAM-EMS Setup dialog box.

LVDAM-EMS Files Compatibility

The configuration files (filename.cfg) created with LVDAM-EMS version 1.12 are compatible with this version of LVDAM-EMS.

The Metering files (filename.met), Oscilloscope files (filename.osc), and Phasor Analyzer files (filename.pha), created with versions 1.2 and up of LVDAM-EMS as well as those created with LVDAM-8032 are compatible with this version of LVDAM-EMS.

The Data Table files and Simulation Parameters files created with previous versions of LVDAM-EMS as well as those created with LVDAM-8032 are compatible with this version of LVDAM-EMS.
Familiarization with the LVDAM-EMS System

INTRODUCTION

This section contains an easy hands-on exercise you can perform to familiarize with the LVDAM-EMS system. The exercise consists of a step-by-step procedure that guides you in the measurement of electrical parameters and the observation of voltage and current waveforms, phasors, and harmonic contents in simple electrical circuits.

Note: This hands-on exercise allows familiarization with the use of the LVDAM-EMS system with the actual electromechanical equipment. If you are using virtual equipment, i.e. the LVSIM®-EMS software, you should perform the familiarization exercise in the user manual of the LVSIM®-EMS software (p/n 30547-E0).

PROCEDURE

CAUTION!

High voltages are present in this hands-on exercise. Do not make or modify any banana jack connections with the power on unless otherwise specified!

Setting Up the Equipment

☐ 1. Install the Power Supply, Resistive Load, Inductive Load, and Data Acquisition Interface (DAI) module in the EMS Workstation.

☐ 2. Make sure the Power Supply is turned off and its voltage control knob is set to the 0 position. Connect the Power Supply to a three-phase power receptacle.

☐ 3. Connect the LOW POWER INPUT of the DAI module to the 24 V - AC output of the Power Supply.

On the Power Supply, turn on the 24-V AC power source. Notice that the POWER ON LED on the DAI module lights up to indicate that correct power is supplied to the module.
4. Connect the equipment as shown in Figure 5-1.

**Note:** The red terminals of inputs E1 and I1 on the DAI module correspond to the terminals marked with a plus (+) sign in Figure 5-1.

![Simple resistive DC circuit diagram](image)

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>R₁ (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>300</td>
</tr>
<tr>
<td>220</td>
<td>1100</td>
</tr>
<tr>
<td>240</td>
<td>1200</td>
</tr>
</tbody>
</table>

Figure 5-1. Simple resistive DC circuit.

On the Resistive Load module, set the toggle switches so that the value of resistor R₁ is equal to the value indicated in Figure 5-1.

Connect the DAI module to the data acquisition card installed in the computer.

**Measuring Parameters in Simple Circuits Using the Metering Window of the LVDAM-EMS System**

5. Start the Metering application of the LVDAM-EMS system. The entry window of the LVDAM-EMS system should appear on the computer screen. Click the Acquisition button in this window to display the Metering window. The LVDAM-EMS system is now ready for measuring parameters in the electrical circuit of Figure 5-1.

6. Turn on meter PQS1. Set meter E1 as a DC voltmeter. Set meter I1 as a DC ammeter. Set meter PQS1 as an active power meter. Turn off meters E2, E3, I2, and I3. Refer to Meter Settings and Shortcuts to Meter Settings in the LVDAM-EMS Help to know how to change the meter settings.
Familiarization with the LVDAM-EMS System

**Note:** All topics in the LVDAM-EMS Help are available in Section 4 of this manual.

☐ 7. Turn on the Power Supply. Observe that meter E1 indicates the DC source voltage, meter I1 indicates the DC current flowing in the circuit, and meter PQS1 indicates the active power dissipated in resistor R₁.

Decrease the value of resistor R₁ by closing switches on the Resistive Load module. While doing this, observe that the values indicated by meters E1, I1, and PQS1 change to reflect the decrease in value of resistor R₁.

☐ 8. Turn off the Power Supply.

Replace the fixed-voltage DC power source with a variable-voltage AC power source, as shown in Figure 5-2.

![Simple resistive AC circuit diagram](image)

<table>
<thead>
<tr>
<th>AC Network Voltage (V)</th>
<th>R₁ (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>300</td>
</tr>
<tr>
<td>220</td>
<td>1100</td>
</tr>
<tr>
<td>240</td>
<td>1200</td>
</tr>
</tbody>
</table>

Figure 5-2. Simple resistive AC circuit.

Set resistor R₁ to the value indicated in Figure 5-2.

☐ 9. Set meter E1 as an AC voltmeter. Set meter I1 as an AC ammeter. Refer to **Meter Settings and Shortcuts to Meter Settings** in the LVDAM-EMS Help to know how to change the meter settings.

Open the Meter Settings dialog box. Refer to **Metering Tool Bar** in the LVDAM-EMS Help to know how to open this dialog box.

Set programmable meter A as a frequency meter (function f(E1)) and programmable meter B as an ohmmeter (impedance...
Familiarization with the LVDAM-EMS System

function RXZ (E1,l1)), turn on these meters, and close the Meter Settings dialog box. Refer to Meter Settings and Technical Information about the Programmable Meter Functions in the LVDAM-EMS Help to know how to change the programmable meter settings.

☐ 10. Turn on the Power Supply. Slowly turn the voltage control knob of the Power Supply until the AC source voltage (indicated by voltmeter E1) is approximately equal to the AC power network voltage. While doing this, observe that the meters are refreshed continuously to reflect the variation of the measured parameters.

☐ 11. Set the Power Supply voltage control knob to the 0 position to reduce the AC source voltage to zero.

Slowly increase the AC source voltage, in approximately ten steps, until it is approximately equal to the AC power network voltage. For each voltage step, record the values indicated by the meters in the Data Table. Refer to Data Menu Commands (Metering) or Metering Tool Bar in the LVDAM-EMS Help to know how to record the values indicated by the meters in the Data Table. Notice that the number of data recorded in the Data Table is indicated in the status bar located at the bottom of the Metering window.

Turn off the Power Supply.

☐ 12. Open the Data Table window and observe that the data indicated by the meters which are turned on have been recorded in the table. Refer to Tools Menu Commands (Metering) or Metering Tool Bar in the LVDAM-EMS Help to know how to open the Data Table.

Print the Data Table. Refer to File Menu Commands (Data Table) in the LVDAM-EMS Help to know how to print the Data Table.

Close the Data Table.

☐ 13. Open the Graph window. Refer to Tools Menu Commands (Metering) or Metering Tool Bar in the LVDAM-EMS Help to know how to open the Graph window.

Plot a graph of the circuit current as a function of the AC source voltage. Refer to X- and Y-Axis Parameter Selection and View Menu Commands (Graph) in the LVDAM-EMS Help to know how to obtain a graph.

Print the graph. Refer to File Menu Commands (Graph) in the LVDAM-EMS Help to know how to print a graph.

Close the Graph window.
Familiarization with the LVDAM-EMS System

Observation of Signal Waveforms in a Simple Circuit Using the Oscilloscope of the LVDAM-EMS System

☐ 14. Turn on the Power Supply. The AC source voltage should be equal to the AC power network voltage.

Start the Oscilloscope application of the LVDAM-EMS system. This can be done from the Metering window. Refer to Tools Menu Commands (Metering) or Metering Tool Bar in the LVDAM-EMS Help to know how to start (or switch to) the Oscilloscope application from the Metering application.

The Oscilloscope of the LVDAM-EMS System should appear on the computer screen.

☐ 15. Set the vertical controls of the Oscilloscope to observe the waveforms of the AC source voltage (E1), circuit current (I1), and active power (P1) dissipated by resistor R, with channels 1, 2, and 3, respectively. Knowing the approximate values of these parameters (they have been measured with the Metering application), set the sensitivity of channels 1 to 3. Refer to Vertical Controls in the LVDAM-EMS Help to know how to set the vertical controls of the Oscilloscope.

Set the Oscilloscope time base to 5 ms/div. Refer to Time Base in the LVDAM-EMS Help to know how to change the Oscilloscope time base.

Set the trigger controls of the Oscilloscope so that it triggers on the positive-slope zero crossing of the AC source voltage. Refer to Trigger Controls in the LVDAM-EMS Help to know how to set the Oscilloscope trigger controls.

Refresh the display of the Oscilloscope. Refer to Display Refresh (Oscilloscope) in the LVDAM-EMS Help to know how to refresh the Oscilloscope display. Readjust the sensitivity of channels 1 to 3 if necessary then refresh the Oscilloscope display. Note that the waveforms are displayed using different colors to facilitate identification.

☐ 16. Select the continuous display refresh mode. Refer to Display Refresh (Oscilloscope) in the LVDAM-EMS Help to know how to select this mode.

Slowly turn the Power Supply voltage control knob to reduce the AC source voltage. While doing this, observe that the Oscilloscope display is refreshed continuously to reflect changes in the observed waveforms.

Select the manual display refresh mode (this stops the continuous display refresh).

Close the Oscilloscope application. The Metering window should reappear on the computer screen.
Observation of Voltage and Current Phasors in a Simple Circuit Using the Phasor Analyzer of the LVDAM-EMS System

☐ 17. Slowly turn the Power Supply voltage control knob until the AC source voltage (indicated by voltmeter E1) is approximately equal to the AC power network voltage.

Start the Phasor Analyzer application of the LVDAM-EMS system. This can be done from the Metering window. Refer to Tools Menu Commands (Metering) or Metering Tool Bar in the LVDAM-EMS Help to know how to start (or switch to) the Phasor Analyzer application from the Metering application.

The Phasor Analyzer of the LVDAM-EMS System should appear on the computer screen.

☐ 18. Select the phasors related to the AC source voltage (E1) and circuit current (I1). Refer to Phasor Selection and Scale Setting in the LVDAM-EMS Help to know how to select phasors.

Select the continuous display refresh mode. Refer to Display Refresh (Phasor Analyzer) in the LVDAM-EMS Help to know how to select this mode.

Notice that a line appears at angle 0° of the Phasor Analyzer display. This line corresponds to the AC source voltage and circuit current phasors (they are superimposed). The color of the line alternates between blue and dark blue, the colors related to parameters E1 (AC source voltage) and I1 (circuit current), respectively. This indicates that the two phasors are superimposed.

Set the voltage and current scales until the lengths of the AC source voltage phasor (blue phasor) and circuit current phasor (dark blue phasor) do not exceed the limits of the display. Refer to Phasor Selection and Scale Setting in the LVDAM-EMS Help to know how to modify the voltage and current scales.

☐ 19. Turn off the Power Supply without modifying the setting of the voltage control knob.

Add an inductor in series with resistor R, as shown in Figure 5-3.
Familiarization with the LVDAM-EMS System

![AC circuit diagram](image)

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>R₁ (Ω)</th>
<th>L₁ (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>300</td>
<td>0.8</td>
</tr>
<tr>
<td>220</td>
<td>1100</td>
<td>3.5</td>
</tr>
<tr>
<td>240</td>
<td>1200</td>
<td>3.8</td>
</tr>
</tbody>
</table>

Figure 5-3. Simple resistive-inductive AC circuit.

Set the value of inductor L₁ to the value indicated in Figure 5-3. This makes the reactance of inductor L₁ equal to the value of resistor R₁.

☐ 20. Turn on the Power Supply and observe that the AC source voltage phasor leads the circuit current phasor by approximately 45°. Observe that the AC source voltage phasor is displayed at angle 0° because it is used as the reference phasor.

Select the circuit current (I₁) as the reference phasor. Refer to Reference Phasor Selection in the LVDAM-EMS Help to know how to select the reference phasor.

Observe that the circuit current phasor is now displayed at angle 0°. Note that changing the reference phasor does not change the phasor relationship, i.e., the AC source voltage phasor still leads the circuit current phasor by approximately 45°.

Slowly turn the Power Supply voltage control knob to reduce the AC source voltage to zero. While doing this, observe that the Phasor Analyzer display is updated continuously to reflect the decrease in amplitude of the observed phasors.

Select the manual display refresh mode (this stops the continuous display refresh).

☐ 21. Turn off the Power Supply.
Familiarization with the LVDAM-EMS System

Close the Phasor Analyzer application. The Metering window should reappear on the computer screen.

**Observation of the Harmonic Contents at the Variable-Voltage DC Output of the Power Supply Using the Harmonic Analyzer of the LVDAM-EMS System**

□ 22. Modify the connections of the equipment to obtain the circuit shown in Figure 5-4.

![Circuit Diagram](image)

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>$R_1$ (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>300</td>
</tr>
<tr>
<td>220</td>
<td>1100</td>
</tr>
<tr>
<td>240</td>
<td>1200</td>
</tr>
</tbody>
</table>

*Figure 5-4. Circuit for measuring the harmonic contents at the variable-voltage DC output of the Power Supply.*

On the Resistive Load module, set the toggle switches so that the value of resistor $R_1$ is equal to the value indicated in Figure 5-4.

□ 23. Turn on the Power Supply and turn the voltage control knob fully clockwise to set the DC voltage to maximum.

Start the Harmonic Analyzer application of the LVDAM-EMS system. This can be done from the Metering window. Refer to *Tools Menu Commands (Metering)* or *Metering Tool Bar* in the LVDAM-EMS Help to know how to start (or switch to) the Harmonic Analyzer application from the Metering application.

The Harmonic Analyzer of the LVDAM-EMS System should appear on the computer screen.

□ 24. Select voltage E1 (voltage at the variable DC output of the Power Supply) as the input parameter to the Harmonic Analyzer. Refer to Input Parameter
Familiarization with the LVDAM-EMS System

in the topic titled Harmonic Analyzer Settings in the LVDAM-EMS Help to know how to make this selection.

Set the fundamental frequency to the frequency of your local AC power network. Refer to Fundamental Frequency in the topic titled Harmonic Analyzer Settings in the LVDAM-EMS Help to know how to make this setting.

Set the Harmonic Analyzer so that the first twenty harmonics of the selected input parameter are displayed. Refer to Number of Harmonics in the topic titled Harmonic Analyzer Settings in the LVDAM-EMS Help to know how to make this setting.

Set the Harmonic Analyzer so that the harmonic levels are displayed on a relative scale graduated in percentage of the level of the DC component of the selected input parameter. Set the vertical scale setting (sensitivity) to 5%/div. Refer to Vertical Scale Settings in the topic titled Harmonic Analyzer Settings in the LVDAM-EMS Help to know how to make this setting.

☐ 25. Refresh the display of the Harmonic Analyzer. Refer to Display Refresh (Harmonic Analyzer) in the LVDAM-EMS Help to know how to refresh the Harmonic Analyzer display.

Observe that the voltage at the variable DC output of the Power Supply consists of a strong DC component and several harmonic components at multiples of three times the fundamental frequency (AC power network frequency). This is normal since the voltage at this output is obtained using a three-phase half-wave diode rectifier.

Observe that the levels of the various harmonics are displayed in the Harmonic Analyzer window as percentages of the DC component level.

Observe that the total harmonic distortion (THD) related to the voltage at the variable DC output of the Power Supply is high. This is normal since the waveform of this voltage is far from resembling a pure sine wave at the AC power network frequency.

☐ 26. Set the Harmonic Analyzer so that the harmonic levels are displayed on a scale graduated in absolute values of voltage. Set the vertical scale setting (sensitivity) to 20 V/div.

Observe that the levels of the various harmonics are displayed in the Harmonic Analyzer window as root-mean-square (RMS) voltages.

☐ 27. Select the Spectrum Analyzer mode of operation of the Harmonic Analyzer. Refer to Options Menu Commands (Harmonic Analyzer) or Harmonic Analyzer Toolbar in the LVDAM-EMS Help to know how to make this selection.
Familiarization with the LVDAM-EMS System

Set the vertical scale setting to 5 V/div. Refer to Vertical Scale Setting in the topic titled Spectrum Analyzer Settings in the LVDAM-EMS Help to know how to make this setting.

Set the frequency span to 100 Hz/div. Refer to Frequency Span in the topic titled Spectrum Analyzer Settings in the LVDAM-EMS Help to know how to make this setting.

☐ 28. Refresh the Harmonic Analyzer display.

Observe that the frequency components of the voltage at the variable DC output of the Power Supply, up to a frequency of 1 kHz, are now displayed in the Harmonic Analyzer window.

☐ 29. Turn off the Power Supply.

Close the Harmonic Analyzer application.

Close the Metering application without saving changes to the Data Table contents and the Metering environment.
Measuring Three-Phase Power with the LVDAM-EMS System

INTRODUCTION

This section contains an easy hands-on exercise you can perform to know how to measure three-phase power using the LVDAM-EMS system. The exercise consists of a step-by-step procedure that shows you two methods for measuring electrical power in three-phase circuits.

Note: This hands-on exercise allows familiarization with the use of the LVDAM-EMS system with the actual electromechanical equipment. If you are using virtual equipment, i.e. the LVSIM®-EMS software, you should perform the familiarization exercise in the user manual of the LVSIM®-EMS software (p/n 30547-EO).

PROCEDURE

CAUTION!

High voltages are present in this hands-on exercise. Do not make or modify any banana jack connections with the power on unless otherwise specified!

Setting Up the Equipment

☐ 1. Install the Power Supply, Resistive Load, and Data Acquisition Interface (DAI) module in the EMS Workstation.

☐ 2. Make sure the Power Supply is turned off and its voltage control knob is set to the 0 position. Connect the Power Supply to a three-phase power receptacle.

☐ 3. Connect the LOW POWER INPUT of the DAI module to the 24 V - AC output of the Power Supply.

On the Power Supply, turn on the 24-V AC power source. Notice that the POWER ON LED on the DAI module lights up to indicate that correct power is supplied to the module.
Measuring Three-Phase Power with the LVDAM-EMS System

4. Connect the equipment as shown in Figure 6-1.

Note: The red terminals of inputs E1 and I1 on the DAI module correspond to the terminals marked with a plus (+) sign in Figure 6-1.

![Diagram of DAI module connection for measuring power in a balanced three-phase circuit.](image)

Figure 6-1. DAI module connection for measuring power in a balanced three-phase circuit.

On the Resistive Load module, set the toggle switches so that the resistance of resistors $R_1$, $R_2$, and $R_3$ is equal to the value indicated in Figure 6-1.

Connect the DAI module to the data acquisition card installed in the computer.

Measuring Power in Balanced Three-Phase Circuits Using the LVDAM-EMS System

5. Start the Metering application of the LVDAM-EMS system. The entry window of the LVDAM-EMS system should appear on the computer screen. Click the Acquisition button in this window to display the Metering window. The LVDAM-EMS system is now ready for measuring parameters in the electrical circuit of Figure 6-1.

6. Set meter E1 as an AC voltmeter. Set meter I1 as an AC ammeter. Turn off meters E2, E3, I2, and I3. Refer to Meter Settings and Shortcuts to Meter Settings in the LVDAM-EMS Help to know how to change the meter settings.

Note: All topics in the LVDAM-EMS Help are available in Section 4 of this manual.
Measuring Three-Phase Power with the LVDAM-EMS System

7. Turn on the Power Supply. Slowly turn the voltage control knob of the Power Supply until the line-to-line voltage (indicated by volt meter E1) is approximately equal to the value given in the following table.

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>LINE-TO-LINE VOLTAGE (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>208</td>
</tr>
<tr>
<td>220</td>
<td>380</td>
</tr>
<tr>
<td>240</td>
<td>415</td>
</tr>
</tbody>
</table>

Table 6-1. Line-to-line voltage of the circuit.

Record the line-to-line voltage and line current (indicated by ammeter I1) in the following blank spaces.

Line-to-Line Voltage ($E_{L-L}$) : ______ V

Line Current ($I_L$) : ______ A

8. Using the measured parameters and the following equation, calculate the active power dissipated in the circuit.

$$P = E_{L-L} \times I_L \times \cos \phi \times 1.73$$

$$P = \text{________________________} = \text{______ W}$$

Note: $\cos \phi$ is equal to 1 because the circuit load is resistive.

9. Open the Meter Settings dialog box. Refer to Metering Tool Bar in the LVDAM-EMS Help to know how to open this dialog box.

Set programmable meter A as a three-phase active power meter by selecting power function PQS1 (E1,I1) 3- and the active power (P) mode, turn on meter A, and close the Meter Settings dialog box. Refer to Meter Settings and Technical Information about the Programmable Meter Functions in the LVDAM-EMS Help to know how to change the programmable meter settings.

Observe that meter A indicates active power, the displayed value being very close to the three-phase active power calculated in the previous step. This method of measuring three-phase power using a single line-to-line voltage and a single line current is valid when the three-phase circuit is balanced.
Measuring Three-Phase Power with the LVDAM-EMS System

Note: Three-phase power in balanced circuits can also be measured using power function PQS2 (E2,I2) 3- and inputs E2 and I2 of the DAI module, or using power function PQS3 (E3,I3) 3- and inputs E3 and I3 of the DAI module.

☐ 10. Set meter A as a reactive power (Q) meter. Refer to Shortcuts to Meter Settings in the LVDAM-EMS Help to know how to quickly change the meter mode of operation.

Observe that the three-phase reactive power indicated by meter A is nearly zero. This is normal because a resistive load draws a negligible amount of reactive power from the three-phase source.

☐ 11. Set meter A as an apparent power (S) meter. Refer to Shortcuts to Meter Settings in the LVDAM-EMS Help to know how to quickly change the meter mode of operation.

Observe that the three-phase apparent power indicated by meter A is equal to the three-phase active power measured previously. This is normal because a resistive load draws a neglectable amount of reactive power from the three-phase source.

Measuring Power in Three-Phase Circuits Using the LVDAM-EMS System (Two-Wattmeter Method)

☐ 12. Turn off the Power Supply without modifying the setting of the voltage control knob.

Modify the connections so that the DAI module is connected as shown in Figure 6-2.

Turn on the Power Supply.

☐ 13. Open the Meter Settings dialog box.

Set programmable meter B as a three-phase active power meter (two-wattmeter method) by selecting power function PQS1 + PQS2 and the active power (P) mode then turn on meter B.

Set meter A as an active power meter then close the Meter Settings dialog box.

Observe that meter B indicates active power, the displayed value being virtually equal to the active power indicated by meter A, and very close to the three-phase active power calculated in step 8.
Measuring Three-Phase Power with the LVDAM-EMS System

Figure 6-2. DAI module connection for measuring power in a three-phase circuit (two-wattmeter method).

14. On the Power Supply, set the voltage control knob so that the line-to-line voltage (indicated by voltmeter E1) is approximately equal to the value given in the following table.

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>LINE-TO-LINE VOLTAGE (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>165</td>
</tr>
<tr>
<td>220</td>
<td>300</td>
</tr>
<tr>
<td>240</td>
<td>330</td>
</tr>
</tbody>
</table>

Table 6-2. Reduced line-to-line voltage of the circuit.

Observe that the three-phase active power indicated by programmable meters A and B decreased because the line-to-line voltage has been decreased.

15. Set resistor R1 to the value indicated in the following table to unbalance the three-phase load. While doing this, observe that the active power indicated by meters A and B changes because the three-phase circuit is now unbalanced.
Measuring Three-Phase Power with the LVDAM-EMS System

<table>
<thead>
<tr>
<th>AC NETWORK VOLTAGE (V)</th>
<th>R₁ (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>600</td>
</tr>
<tr>
<td>220</td>
<td>2200</td>
</tr>
<tr>
<td>240</td>
<td>2400</td>
</tr>
</tbody>
</table>

Table 6-3. Value of resistor R₁.

Observe that the values of three-phase active power indicated by meters A and B differ. The correct value is indicated by meter B because the two-wattmeter method of measuring power is valid whether or not the three-phase circuit is balanced.

☐ 16. Turn off the Power Supply.

Close the Metering application without saving changes to the Metering environment.